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1. About This IP Core

The 10-Gbps Ethernet (10GbE) Media Access Controller (MAC) IP core is a
configurable component that implements the IEEE 802.3-2008 specification. The IP
core offers the following modes:

10 Gbps mode—uses the Avalon® Streaming (Avalon-ST) interface on the client
side and the single data rate (SDR) XGMII on the network side.

1 Gbps/10 Gbps mode— uses the Avalon-ST interface on the client side and
GMII/SDR XGMII on the network side.

10 Mbps /100 Mbps/1 Gbps/10 Gbps (10M-10G) mode—uses the Avalon-ST
interface on the client side and MII/GMII/SDR XGMII on the network side.

To build a complete Ethernet subsystem in an Altera® device and connect it to an
external device, you can use the 10GbE MAC IP core with an Altera PHY IP core such
as a soft XAUI PHY in FPGA fabric, hard silicon-integrated XAUI PHY, a 10GBASE-R
PHY, a Backplane Ethernet 10GBASE-KR PHY, or a 1G/10 Gbps Ethernet PHY IP.

Figure 1-1 illustrates a system with the 10GbE MAC IP core.

Figure 1-1. Typical Application of 10GbE MAC

Altera FPGA
XAUI or
> 10GbE MAC or > >
10GBASE-R or
Client Avalon-ST 1G/10GbE MAC or | DR XGMII/ Serial External PHY
Module Interface GMI/MII Backplane Ethernet Interface
10MA00M/ 10GBASE-KR PHY or

1000M/10GbE MAC
1G/10Gbps Ethernet

1.1. Features
The 10GbE MAC supports the following features:

February 2014  Altera Corporation

Operating modes: 10 Mbps, 100 Mbps, 1 Gbps and 10 Gbps.
Support for full duplex only.
Avalon-ST 64-bit wide client interface running at 156.25 MHz.

Direct interface to 4-bit MII running at 125 MHZ with clock enable; 2.5 MHz for
10 Mbps and 25 MHz for 100 Mbps.

Direct interface to 8-bit GMII running at 125 MHZ.
Direct interface to 64-bit SDR XGMII running at 156.25 MHZ.

Virtual local area network (VLAN) and stacked VLAN tagged frames filtering as
specified by IEEE 802.1Q and 802.1ad (Q-in-Q) standards respectively.

10-Gbps Ethernet MAC MegaCore Function User Guide
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Release Information

Optional cyclic redundancy code (CRC)-32 computation and insertion on the
transmit datapath; CRC checking on the receive datapath with optional
forwarding of the frame check sequence (FCS) field to the client application.

Checking of receive frames for FCS error, undersized and oversized frames, and
payload length error.

Deficit idle counter (DIC) for optimized performance with average inter-packet
gap (IPG) of 12 bytes for LAN applications.

Optional statistics collection on the transmit and receive datapaths.
Packets termination when the transmit datapath receives incomplete packets.

Programmable maximum length of transmit and receive frames up to
64 Kbytes (KB).

Programmable promiscuous (transparent) mode.

Optional Ethernet flow control and priority-based flow control (PFC) using pause
frames with programmable pause quanta. The PFC supports up to 8 priority
queues.

Optional padding termination on the receive datapath and insertion on the
transmit datapath.

Design examples with optional loopback and testbench for design verification.

Optional preamble passthrough mode on the transmit and receive datapaths. The
preamble passthrough mode allows you to define the preamble in the client frame.

Programmable datapath option to allow separate instantiation of MAC TX block,
MAC RX block, or both MAC TX and MAC RX blocks.

Optional IEEE 1588v2 feature for the following configurations:
m  10GbE MAC with 10GBASE-R PHY MegaCore function

m  1G/10GbE MAC with Backplane Ethernet 10GBASE-KR PHY MegaCore
function

m  Multi-speed 10M-10GbE MAC with Backplane Ethernet 10GBASE-KR PHY
MegaCore function

1.2. Release Information

Table 1-1 lists information about this release of the 10GbE MAC IP core.

Table 1-1. Release Information

Item Description
Version 13.1
Release Date November 2013
Ordering Code IP-10GETHMAC
Product ID ID 00D9
Vendor ID 6AF7

10-Gbps Ethernet MAC MegaCore Function User Guide February 2014  Altera Corporation
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Device Family Support

1.3. Device Family Support

MegaCore functions provide the following support for Altera device families:

m  Preliminary support—Altera verifies the IP core with preliminary timing models for

this device family. The core meets all functional requirements, but might still be
undergoing timing analysis for the device family. It can be used in production

designs with caution.

m Final support—Altera verifies the IP core with final timing models for this device
family. The core meets all functional and timing requirements for the device family

and can be used in production designs.

Table 1-2 shows the level of support offered by the 10GbE MAC for the following

Altera device family.

Table 1-2. Device Family Support for 10GhE MAC

Device Family Support
Arria® 1l GX, GZ Final
Arria V GT, GX, and GZ Preliminary
Arria V SoC Preliminary
Cyclone® IV GX Final
Cyclone V Preliminary
Cyclone V SoC Preliminary
Stratix Il Final
Stratix IV Final
Stratix V Preliminary

Table 1-3 shows the devices supported by the different configurations.

Table 1-3. Device Family Support for Configurations

Configuration Arria V GT

Arria V GZ

Stratix V

Multi-Speed 10M-10GbE MAC —

Multi-Speed 10M-10GbE MAC with IEEE 1588v2 —

10GbE MAC with 10GBASE-R PHY v

10GbE MAC with 10GBASE-R PHY and IEEE

1588v2

Multi-Speed 10M-10GbE MAC with Backplane
Ethernet 10GBASE-KR PHY

S SIKNS

AR NEANANEN

Multi-Speed 10M-10GbE MAC with Backplane
Ethernet 10GBASE-KR PHY and IEEE 1588v2

Multi-Speed 10M-10GbE MAC with 1G/10Gbps

Ethernet PHY

AN

<

Multi-Speed 10M-10GbE MAC with 1G/10Gbps
Ethernet PHY and IEEE 1588v2

Note for Table 1-3:

(1) Supports only Arria V GT devices with speed grade of 3_H3.

February 2014  Altera Corporation
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1.4. IP Core Verification

To ensure compliance with the IEEE specification, Altera performs extensive
validation of the 10GbE MAC IP core. Validation includes both simulation and
hardware testing.

1.4.1. Simulation Environment
Altera performs the following tests in the simulation environment:

m Directed tests that test all types and sizes of transaction layer packets and all bits of
the configuration space.

m Error injection tests that inject errors in the link, transaction layer packets, and data
link layer packets, and check for the proper response from the IP core.

B Random tests that test a wide range of traffic patterns across one or more virtual
channels.

1.4.2. Compatihility Testing Environment

Altera has performed significant hardware testing of the 10GbE MAC IP core to
ensure a reliable solution. The IP core has been tested with the following devices:

m Arria V, Stratix IV, and Stratix V

m Soft XAUIPHY

m Soft and hard 10GBASE-R PHY

m Hard Backplane Ethernet 10GBASE-KR PHY
m 1G/10Gbps Ethernet PHY

The IP core has passed all interoperability tests conducted by the UNH. In addition,
Altera internally tests every release with the Spirent Ethernet and 10G testers.

1.5. Performance and Resource Utilization

Table 1-4 provides the estimated performance and resource utilization of the 10GbE
MAC for the Cyclone IV device family. The estimates are obtained by compiling the
10GbE MAC with the Quartus II software targeting a Cyclone IV
(EP4CGX110DF31C7) device with speed grade —7.

I'=" To achieve your timing requirement in the Quartus II software, Altera recommends
that you use multiple seeds in the Design Space Explorer to find the optimal Fitter
settings for your design, follow the recommendations of the Timing Optimization
Advisor, apply the Speed Optimization Technique and use the LogicLock regions.

Table 1-4. Cyclone IV Performance and Resource Utilization

Settings Logic Elements Logic Registers Memory Block (M9K) | fyax (MHz)
All options disabled
4,424 3,245 2 >156.25
All options enabled with 11,845 8,355 11 5156.25

memory-based statistics counters

10-Gbps Ethernet MAC MegaCore Function User Guide February 2014  Altera Corporation
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Performance and Resource Utilization

Table 1-5 provides the estimated performance and resource utilization of the

10GbE MAC for the Stratix IV device family. The estimates are obtained by compiling
the 10GbE MAC with the Quartus II software targeting a Stratix IV GX
(EP4SGX70HF35C2) device with speed grade -2.

Table 1-5. Stratix IV Performance and Resource Utilization

Settings Combinational ALUTs Logic Registers Memory Block (M9K) | fyax (MHz)
All options disabled
1,954 3,157 0 >156.25
All options enabled .Wllth 5,684 8,349 7 5156.95
memory-based statistics counters
All options enabled with
register-based statistics counters 8,135 10,17 3 >156.25

Table 1-6 provides the estimated performance and resource utilization of the

10GbE MAC for the Cyclone V device family. The estimates are obtained by compiling
the 10GbE MAC with the Quartus II software targeting a Cyclone V GX
(5CGXFC7D6F31C6) device with speed grade —6.

Table 1-6. Cyclone V Performance and Resource Utilization

Settings Combinational ALUTs | Logic Registers | Memory Block (M10K) |  fy;ax (MHz2)
All options disabled
2,322 3,444 2 >156.25
Al options enabled with 4417 5,464 6 5156.25
memory-based statistics counters
All options enabled with 6,867 7113 2 5156.25
register-based statistics counters

Table 1-7 provides the estimated performance and resource utilization of the

10GbE MAC for the Stratix V device family. The estimates are obtained by compiling
the 10GbE MAC with the Quartus II software targeting a Stratix V GX
(5SGXEA7H3F35C3) device with speed grade -3.

Tahle 1-7. Stratix V Performance and Resource Utilization for 10GhE MAC (Part 1 of 2)

. I Dedicated Logic
Settings Combinational ALUTs Registers Memory Block (M20K) | fyax (MH2)

All options disabled

2,001 3,077 0 >156.25
Al options enabled with 5,772 8,197 7 >156.25
memory-based statistics counters
All options enabled with 8,202 9,965 3 >156.25
register-based statistics counters

February 2014  Altera Corporation
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Table 1-7. Stratix V Performance and Resource Utilization for 10GhE MAC (Part 2 of 2)

. — Dedicated Logic
Settings Combinational ALUTs Registers Memory Block (M20K) | fyax (MH2)

IEEE 1588v2 feature enabled with
2-step synchronization

m Timestamping is enabled 4.827 5,921 8 >156.25
m ptp_1step is disabled
IEEE 1588v2 feature enabled with
1-step and 2-step synchronization
6,822 7,926 11 >156.25

m Timestamping is enabled
m ptp_1step is disabled

Table 1-8 provides the estimated performance and resource utilization of the
multi-speed 10M-10GbE MAC for the Stratix V device family. The estimates are
obtained by compiling the 10M-10GbE MAC with the Quartus II software targeting a
Stratix V GX (5SGXEA7H3F35C3) device with speed grade —3.

Table 1-8. Stratix V Performance and Resource Utilization for 10M-10GhE MAC

. - Dedicated Logic
Settings Combinational ALUTs Registers Memory Block (M20K) | fyax (MH2)
All options disabled
3,654 4,645 7 >156.25
Al options enabled with 4,877 5797 11 >156.25
memory-based statistics counters
All options enabled with 7313 7,544 7 156.25

register-based statistics counters
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This chapter provides a general overview of the Altera IP core design flow to help you
quickly get started with any Altera IP core. The Altera IP Library is installed as part of
the Quartus Il installation process. You can select and parameterize any Altera IP core
from the library. Altera provides an integrated parameter editor that allows you to
customize IP cores to support a wide variety of applications. The parameter editor
guides you through the setting of parameter values and selection of optional ports.
The following sections describe the general design flow and use of Altera IP cores.

2.1. Installation and Licensing

The Altera IP Library is distributed with the Quartus II software and
downloadable from the Altera website (www.altera.com).

Figure 2—1 shows the directory structure after you install an Altera IP core, where
<path> is the installation directory. The default installation directory on Windows is
C:\altera\<version number>; on Linux it is /opt/altera<version number>.

Figure 2-1. IP core Directory Structure

D <path>
Installation directory

ip
Contains the Altera IP Library and third-party IP cores

altera
Contains the Altera IP Library

common
Contains shared components

<IP core name>
Contains the IP core files and documentation

You can evaluate an IP core in simulation and in hardware until you are satisfied with
its functionality and performance. Some IP cores require that you purchase a license
for the IP core when you want to take your design to production. After you purchase
a license for an Altera IP core, you can request a license file from the Altera Licensing
page of the Altera website and install the license on your computer. For additional
information, refer to Altera Software Installation and Licensing.
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2.2. Design Flows

You can use the following flow(s) to parameterize Altera IP cores:

m “MegaWizard Plug-In Manager Flow”

B “Qsys System Integration Tool Design Flow”

Figure 2-2 shows the design flows for the MegaWizard Plug-In Manager and Qsys

system integration tool.

Figure 2-2. Design Flows
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2.3. MegaWizard Plug-In Manager Flow

The MegaWizard Plug-In Manager flow allows you to customize the 10GbE MAC IP
core and manually integrate the function into your design.

2.3.1. Specifying Parameters

To specify the 10GbE MAC IP core parameters with the MegaWizard Plug-In
Manager, follow these steps:

1. Open an existing Quartus II project or create a new project using the New Project
Wizard available from the File menu.
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2. In the Quartus II software, launch the MegaWizard Plug-in Manager from the
Tools menu, and follow the prompts in the MegaWizard Plug-In Manager
interface to create or edit a custom IP core variation.

3. In the Installed Plug-Ins list on page 2a of the MegaWizard Plug-In Manager
interface, expand the Interfaces folder and then the Ethernet folder. Select
Ethernet 10G MAC. Specify the type and name of the output file you want to
create.

4. Specify the parameters on the Parameter Settings pages. For detailed explanations
of these parameters, refer to “10GbE MAC Parameter Settings” on page 2-6.

5. Specify appropriate options in the wizard to generate a simulation model.

L=~ Altera IP supports a variety of simulation models, including
simulation-specific IP functional simulation models and encrypted RTL
models. These are all cycle-accurate models. The models allow for fast
functional simulation of your IP core instance using industry-standard
VHDL or Verilog HDL simulators.

“ e For more information about functional simulation models for Altera IP

cores, refer to Simulating Altera Designs in volume 3 of the Quartus 11
Handbook.

Use the simulation models only for simulation and not for synthesis or any
other purposes. Using these models for synthesis creates a nonfunctional
design.

CAUTION

6. Click Finish. The parameter editor generates the top-level HDL code for the
10GbE MAC IP core and a simulation directory which includes files for
simulation.

=~ The Finish button may be unavailable until all parameterization errors
listed in the messages window are corrected.

7. Click Yes if you are prompted to add the Quartus II IP File (.qip) to the current
Quartus II project. You can also turn on Automatically add Quartus II IP Files to
all projects.

You can now integrate your custom 10GbE MAC IP core instance in your design,
simulate, and compile.
“ e TFor information about the Quartus II software and the MegaWizard Plug-In Manager,
refer to Quartus II Help.

2.3.2. Simulate the IP Core

You can simulate the 10GbE MAC IP core with the functional simulation model
generated by the Quartus Il software. To perform a successful simulation of the 10GbE
MAC IP core using the MegaWizard Plug-In Manager flow, you are required to
compile all files listed in the <project directory>/<variation name>_sim output file.
Otherwise, the simulation may fail.
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For more information about simulating Altera IP cores, refer to Simulating Altera
Designs in volume 3 of the Quartus II Handbook.

2.4. Qsys System Integration Tool Design Flow

You can use the Qsys system integration tool to build a system that includes your
customized IP core. You easily can add other components and quickly create a Qsys
system. Qsys automatically generates HDL files that include all of the specified
components and interconnections. In Qsys, you specify the connections you want.
The HDL files are ready to be compiled by the Quartus II software to produce output
files for programming an Altera device.

Figure 2-3 shows a high level block diagram of an example Qsys system.

Figure 2-3. Example Qsys System
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Controller CSR

PHY
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Ethernet Ethernet
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For more information about the Qsys system interconnect, refer to the Qsys
Interconnect chapter in volume 1 of the Quartus II Handbook and to the Avalon Interface
Specifications.

For more information about the Qsys tool and the Quartus II software, refer to the
System Design with Qsys section in volume 1 of the Quartus I Handbook and to Quartus
IT Help.

2.4.1. Specify Parameters

To specify parameters for your IP core using the Qsys flow, follow these steps:

1. Open an existing Quartus II project or create a new project using the New Project
Wizard available from the File menu.

2. On the Tools menu, click Qsys.

3. On the Component Library tab, expand the Interfaces Protocols list and then the
Ethernet list. Double-click Ethernet 10G MAC to add it to your system. The
relevant parameter editor appears.
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4. Specify the required parameters in the Qsys tool. For detailed explanations of

5.

these parameters, refer to “10GbE MAC Parameter Settings” on page 2-6.

Click Finish to complete the IP core instance and add it to the system.

2.4.2. Complete the Qsys System

To complete the Qsys system, follow these steps:

1.
2.

Add and parameterize any additional components.

Connect the components using the Connections panel on the System Contents
tab.

In the Export As column, enter the name of any connections that should be a
top-level Qsys system port.

If you intend to simulate your Qsys system, on the Generation tab, turn on one or
more options under Simulation to generate desired simulation files.

If you want to generate synthesis RTL files, turn on Create HDL design files for
synthesis.

Click Generate to generate the system. Qsys generates the system and produces
the <system name>.qip file that contains the assignments and information required
to process the IP core or system in the Quartus II Compiler.

In the Quartus II software, click Add/Remove Files in Project on the Project menu
and add the .qip file to the project.

Compile your design in the Quartus II software.

2.4.3. Simulate the System

During system generation, Qsys generates a functional simulation model which you
can use to simulate your system easily in any Altera-supported simulation tool.

February 2014

For information about the latest Altera-supported simulation tools, refer to the
Quartus 11 Software Release Notes.

For general information about simulating Altera IP cores, refer to Simulating Altera
Designs in volume 3 of the Quartus II Handbook.

For information about simulating Qsys systems, refer to the System Design with Qsys
section in volume 1 of the Quartus II Handbook.
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2.5. 10GbE MAC Parameter Settings

You customize the 10GbE MAC by specifying the parameters on the MegaWizard
Plug-in Manager, or Qsys in the Quartus II software. Table 2-1 describes the
parameters and how they affect the behavior of the IP core.

Table 2-1. 10GbE Parameters

Parameter

Description

Speed select for 10G MAC

Use this parameter to select the speed options. By default, the 10G MAC option is
selected. Select Enable 1G/10G MAC to implement the 10-Gbps and 1-Gbps MAC;
select Enable Multi-Speed 10M-10Gb MAC to implement the 10-Mbps, 100-Mbps, 1-
Gbps, and 10-Gbps MAC.

Preamble pass-through mode

Turn on this parameter to enable the preamble passthrough mode. To enable the
preamble passthrough mode, you must turn on this parameter and set the
tx_preamble control, rx lane decoder preamble control, and

rx preamble inserter control registersto 1.

This parameter is disabled if you selected Enable 1G/10G MAC.

Priority-based flow control (PFC)

Turn on this parameter to enable PFC. Refer to “Priority-Based Flow Control” on
page 7-19 for more information on PFC and its operations.

Number of PFC priorities

Indicates the number of PFG priority levels that the 10GbE MAC IP core supports. The
valid range is from 2 to 8. This option is enabled only if you turn on the Priority-based
flow control (PFC) parameter.

Datapath option

Use this parameter to select the datapath option that determines the MAC variation to
instantiate. By default, the TX & RX option is selected. The default datapath
instantiates the MAC TX and MAC RX blocks. Selecting TX only instantiates the MAC
TX block; selecting RX only instantiates the MAC RX block.

Supplementary address

Turn on this parameter to enable supplementary addresses. To enable supplementary
addresses, you must turn on this parameter and set the EN_suppo/1/2/3 bits in the
rx_frame control register to 1.

CRC on transmit path

Turn on this parameter to calculate and insert CRC on the transmit datapath. To
compute and insert CRC on the transmit datapath, you must turn on this parameter
and set the tx_crcins control[1] register bitto 1.

Statistics collection

Turn on this parameter to collect statistics on the transmit and receive datapaths.

Statistics counters

When you turn on Statistics collection, the default implementation of the statistics
counters is Memory-based.

Use Memory-based statistics counters to free up the logic elements (the MAC does
not clear the statistic counters after the counters are read); Register-based statistics
counters to free up the memory (the MAC clears the statistic counters after the
counters are read).

Register-based statistics counters are not supported for Cyclone IV GX devices.

Enable time stamping

Turn on this parameter to enable time stamping on the transmitted and received
frames.

Enable PTP 1-step clock support

Turn on this parameter to insert time stamp on PTP messages for 1-step clock based
on the TX Egress Timestamp Insert Control interface.

This parameter is disabled if you do not turn on Enable time stamping.

Timestamp fingerprint width

Use this parameter to set the width in bits for the time stamp fingerprint on the TX
path. The default value is 4 bits.

10-Gbps Ethernet MAC MegaCore Function User Guide
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You can use the following 10GbE design examples and testbenches to help you get
started with the 10GbE MAC IP core and use the core in your design:

m 10GbE MAC with XAUI PHY
m 10GbE MAC with 10GBASE-R PHY

['=~ XAUIPHY and 10GBASE-R PHY do not support Stratix III devices.

3.1. Software and Hardware Requirements

Altera uses the following hardware and software to test the 10GbE design examples
and testbenches:

® Quartus II software 13.1
m Stratix IV GX FPGA development kit (for XAUI PHY)

m Transceiver Signal Integrity development kit, Stratix IV GT Edition (for
10GBASE-R PHY)

B ModelSim®-AE 6.6¢, ModelSim-SE 6.6¢ or higher

e For more information on the development kits, refer to the following documents:

m  Stratix IV GX Development Kit User Guide

m  Stratix IV GX Development Kit Reference Manual

m  Transceiver Signal Integrity Development Kit, Stratix IV GT Edition User Guide

m  Transceiver Signal Integrity Development Kit, Stratix IV GT Edition Reference Manual
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3.2. 10GhE Design Example Components

You can use the 10GbE MAC IP core design example to simulate a complete 10GbE
design in an Altera FPGA. You can compile the design example using the simulation
files generated by the Quartus II software and program the targeted Altera device
after a successful compilation.

Figure 3-1 shows the block diagram of the 10GbE design examples.

Figure 3-1. 10GbE Design Example Block Diagram

Altera FPGA

Client
Application

64-bit Avalon-ST

64 Avalon-ST 64
Single-Clock / Dual-Clock
\ FIFO

Rx FIFO Buffer Tx FIFO Buffer

A

64Y" 64-bit Avalon-ST 64

Configuration and Debugging Tools

Client Application 10GbE MAC

(Configuration, Status, and <
Statistics) 32
32-bit
Avalon-iYIM

> Pipeline Bridge

32

4

72} 72-bit SDR XGMII 72

32-bit Avalon-MM

JTAG to Avalon Master
g Bridge

- Ethernet
Loopback

72} 72-bit SDR XGMII 72

XAUI
or
10GBASE-R
PHY

MDIO < £

A
XAUI/ 10GBASE-R

System Console
(for debugging)

MDIO Signals

External
PHY

10-Gbps Ethernet MAC MegaCore Function User Guide

February 2014  Altera Corporation



Chapter 3: 10GbE MAC Design Examples 3-3
10GbE Design Example Components

The design example comprises the following components:

m 10GbE Ethernet MAC—the MAC IP core with default settings. This IP core
includes memory-based statistics counters.

m XAUIPHY or 10GBASE-R PHY—the PHY IP core with default settings. The XAUI
PHY is set to Hard XAUI by default.

m Ethernet Loopback— the loopback module provides a mechanism for you to
verify the functionality of the MAC and PHY. Refer to Section 3.2.0.1, Ethernet
Loopback Module for more information about this module.

m RX and TX FIFO buffers—Avalon-ST Single-Clock or Dual-Clock FIFO cores that
buffer receive and transmit data between the MAC and client. These FIFO buffers
are 64 bits wide and 512 bits deep. The default configuration is Avalon-ST
Single-Clock FIFO, which operates in store and forward mode and you can
configure it to provide packet-based flushing when an error occurs.

=~ To enable the Avalon-ST Single-Clock FIFO to operate in cut through mode,
turn off the Use store and forward parameter in the Avalon-ST Single
Clock FIFO parameter editor.

m Configuration and debugging tools—provides access to the registers of the
following components via the Avalon Memory-Mapped (Avalon-MM) interface:
MAC, MDIO, Ethernet loopback, PHY, and FIFO buffers. The provided testbench
includes an Avalon driver which uses the pipeline bridge to access the registers.
You can use the system console to access the registers via the JTAG to Avalon
Master Bridge core when verifying the design in the hardware.

“%e Tolearn more about the components, refer to the respective documents:

m XAUI PHY and 10GBASE-R PHY, refer to Altera Transceiver PHY IP Core User
Guide.

m  Avalon-ST Single-Clock or Dual-Clock FIFO, JTAG to Avalon Master Bridge, and
MDIO cores, refer to Embedded Peripherals IP User Guide.

m Pipeline bridge, refer to Avalon Memory-Mapped Bridges in volume 4 of the Quartus
II Handbook.

m System Console, refer to Analyzing and Debugging Designs with the System Console in
volume 3 of the Quartus Il Handbook.

3.2.0.1. Ethernet Loopback Module

You can enable one of the following loopback types:

m Local loopback—turn on this loopback to verify the functionality of the MAC
during simulation. When you enable the local loopback, the Ethernet loopback
module takes the transmit frame from the MAC XGMII TX and loops it back to the
MAC XGMII RX datapath. During this cycle, the loopback module also forwards
the TX frame to the PHY. While the local loopback is turned on, the loopback
module ignores any frame it receives from the PHY.
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m Line loopback—turn on this loopback to verify the functionality of the PHY when
verifying the design example in hardware. When you enable the line loopback, the
Ethernet loopback module takes the XGMII RX signal received from the PHY and
loops it back to the PHY’s XGMII TX signal. During this cycle, the loopback
module also forwards the XGMII RX signal to the MAC. While the line loopback is
turned on, the loopback module ignores any frame transmitted from the MAC.

Table 3-1 describes the registers you can use to enable or disable the desired loopback.

Tahle 3-1. Loopback Registers

Byte Offset Register Description
0x00 line loopback Set this register to 1 to enable line loopback; 0 to disable it.
0x04 Reserved —
0x08 local loopback Set this register to 1 to enable local loopback; 0 to disable it.

3.2.0.2. Base Addresses

Table 3-2 lists the design example components that you can reconfigure to suit your
verification objectives. To reconfigure the components, write to their registers using
the base addresses listed in the table and the register offsets described in the
components' user guides. Refer to Table 3-1 for the Ethernet loopback registers.

Tahle 3-2. Base Addresses of Design Example Components

Component Base Address
10GbE MAC 0x000
XAUI or 10GBASE-R PHY 0x40000
MDIO 0X10000
Ethernet loopback 0x10200
RX FIFO (Avalon-ST Single-Clock FIFQ) 0x10400
TX FIFO (Avalon-ST Single-Clock FIFO) 0x10600

L=~ This design example uses a 19-bit width address bus to access the base address of

components other than the MAC.

10-Gbps Ethernet MAC MegaCore Function User Guide
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3.3. 10GhE Design Example Files

Figure 3-2 shows the directory structure for the design examples and testbenches. The
..\esr_script directory contains the design example script files.

Figure 3-2. Design Example Folders

D <ip_lib>/ethernet/altera_eth_10g_design_example
{Ea@lteraeth1 0g_mac_hase_r
testhench
{Ea@lleraeth1 0g_mac_base_r_sv
testbench
{Eamnera_emj 0g_mac_xaui
testbench
{Ea@ltera_elhj 0g_mac_xaui_sv
testbench

{0 csr_scripts
— design_example_components

4@ source

Table 3-3 lists the design example files. For the description of testbench files, refer to
Table 3-5 on page 3-10.

Table 3-3. 10GhE Design Example Files (Part 1 of 2)

File Name Description

A Tcl script that creates a new Quartus Il project
and sets up the project environment for your
design example. Not applicable for Stratix V
design.

A Tcl script that creates a new Quartus Il project
setup_proj_sv.tcl for Stratix V design and sets up the project
environment for your design example.

A Qsys file for the 10GbE MAC and XAUI PHY

altera_eth_10g_design_mac_xaui.qsys design example. The PHY is set to hard XAUI by
default.

A Qsys file for the 10GbE MAC and XAUI PHY
design example with the Quartus Il software
targeting the Stratix V device. The PHY is set to
hard XAUI by default.

A Qsys file for the 10GbE MAC and 10GBASE-R
PHY design example.

A Qsys file for the 10GbE MAC and 10GBASE-R
altera_eth_10g_design_mac_base_r_sv.qsys | PHY design example with the Quartus Il software
targeting the Stratix V device.

setup_proj.tcl

altera_eth_10g_design_mac_xaui_sv.qsys

altera_eth_10g_design_mac_base_r.qsys
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3.4. Creating a New 10GhE Design

Table 3-3. 10GbE Design Example Files (Part 2 of 2)

File Name

Description

setup_SIVGX230C2ES.tcl

A Tcl script that sets the pin assignments and 1/0
standards for the Stratix IV GX FPGA
development board. Use this Tcl script for the
10GbE MAC with XAUI PHY design example.

setup_EP4S100G5H4013.tcl

A Tcl script that sets the pin assignments and 1/0
standards for the Stratix IV GT Signal Integrity
development board. Use this Tcl script for the
10GbE MAC with 10GBASE-R PHY design
example.

setup_SSGXEA7N2F40C2ES.tcl

A Tcl script that sets the pin assignments and 1/0
standards for the Stratix V GX Signal Integrity
development board. Use this Tcl script for the
10GbE MAC with 10GBASE-R PHY design
example.

The Quartus 11 SDC constraint file for use with

top.sdc the TimeQuest timing analyzer.

The top-level entity file of the design example for
top.v verification in hardware. Not applicable for

Stratix V design.

The top-level entity file of the design example—
top_sv.v with the Quartus Il software targeting the

Stratix V device—for verification in hardware.

A Tcl script that contains basic functions based
common.icl on the system console APIs to access the

registers through the Avalon-MM interface.
config.tcl A Tcl script that configures the design example.

A Tcl script that maps address to the Avalon-MM
csr_pkg.tcl control registers. The script contains APIs which

is used by config.tcl and show_stats.tcl.

show_stats.tcl

A Tcl script that displays the MAC statistics
counters.

altera_eth_10g_design_example_hw.tcl

A hardware Tcl script that contains the
composition of the Ethernet system.

You can use the Quartus II software to create a new 10GbE design. Altera provides a
customizable Qsys design example file to facilitate the development of your 10GbE
design. Follow these steps to create the design:

1. Copy the respective design example directory to your preferred project directory:
altera_eth_10g_mac_xaui or altera_eth_10g_mac_base_r from
<ip library>/ethernet/altera_eth_10g_design_example.

2. Launch the Quartus II software and open the top.v file from the project directory.

10-Gbps Ethernet MAC MegaCore Function User Guide
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3. Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu and then selecting Tcl Console. In the Quartus II Tcl Console window,
type the following command to set up the project environment:

source setup proj.tcl+
4. Load the pin assignments and I/0O standards for the development board:

m  For the 10GbE MAC with XAUI PHY design example, type the following
command:

source setup SIVGX230C2ES.tcl¢

This command assigns the XAUI serial interface to the pins that are connected
to the HSMC Port A of the Stratix IV GX development board.

m  For the 10GbE MAC with 10GBASE-R design example, type the following
command:

source setup EP4S100G2F40I1.tcl¢

This command assigns the 10GBASE-R serial interface to the pins that are
connected to the SMA connectors (J38 to J41) of the Stratix IV GT development
board.

“ e For more information about the development boards, refer to the respective
reference manuals: Stratix IV GX Development Kit Reference Manual or
Transceiver Signal Integrity Development kit, Stratix IV GT Edition Reference
Manual.

5. Launch Qsys from the Tools menu and open the altera_eth_10g_mac_base_r.qsys
or altera_eth_10g_mac_xaui.qsys file. For design targeting the Stratix V device
family, use the altera_eth_10g_mac_base_r_sv.qsys or
altera_eth_10g_mac_xaui_sv.qsys file.

"=~ By default, the design example targets the Stratix IV device family. To
change the target device family, click on the Project Settings tab and select
the desired device from the Device family list.

6. Turn off the additional module under the Use column if your design does not
require them. This action disconnects the module from the 10GbE system.
7. Double-click eth_10g_design_example_0 to launch the parameter editor.

8. Specify the required parameters in the parameter editor. For detailed explanations
of these parameters, refer to “10GbE Design Example Parameter Settings” on
page 3-8.

9. Click Finish.

10. On the Generation tab, select either a Verilog HDL or a VHDL simulation model
and make sure that the Create HDL design files for synthesis option is turned on.

11. Click Generate to generate the simulation and synthesis files.
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3.5. 10GhE Design Example Parameter Settings

You can customize the 10GbE design example by specifying the parameters using the
parameter editor. Table 3—4 describes these parameters.

Tahle 3-4. Design Example Parameters

Name Value Description
Configuration
MDIO Specifies whether the Ethernet system requires a MDIO core to
MDIO access the external PHY device management registers for
None configuration and management purposes.
XAUI PHY Specifies which protocol-specific PHY IP core to use for the
PHY IP 10GBase-R PHY Ethernet system. For XAUI PHY, you can choose to implement the
None system in soft or hard logic.

. Specifies which FIFO buffer to use for the Ethernet system. The
Avalon-ST Single Clock FIFO | o210n-ST Single Clock FIFO operates with a common clock for the
Avalon-ST Dual Clock FIFO input and output ports while the Avalon-ST Dual Clock FIFO

FIFO Avalon-ST Single Clock FIFO operates with independent clocks for the input and output ports.

+ Avalon-ST Dual Clock FIFO | You cannot enable a different FIFO option for TX datapath and RX
None datapath. If you select Avalon-ST Single Clock FIFO, the design
includes single clock FIFO at both TX and RX datapaths.

=~ The parameter values you select on Configuration tab correspond with the
other tabs that require further parameterization. You should only
parameterize the components you selected and omit the others. Editing the
component parameters that were not selected may cause the system
generation to fail.

“ e For more information about the parameter settings of other components,
refer to the respective documents:
m 10GbE MAC, refer to “10GbE MAC Parameter Settings” on page 2-6.

m  Avalon-ST Single-Clock or Dual-Clock FIFO and MDIO core, refer to
Embedded Peripherals IP User Guide.

= XAUIPHY and 10GBASE-R PHY, refer to Altera Transceiver PHY IP Core
User Guide.

3.6. 10GbE Testhenches

Altera provides testbenches for you to verify the design examples. The following
sections in this document describe the testbench, its components, and use.

3.6.1. 10GbE Testhench

The testbenches operate in loopback mode. Figure 3-3 shows the flow of the packets.
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Figure 3-3. Testhench Block Diagram
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3.6.2. 10GhE Testhench Component

The 10GbE testbench comprises the following modules:
m Device under test (DUT)—the design example.

B Avalon driver—uses Avalon-ST bus functional models (BFMs) to exercise the
transmit and receive paths. The driver also utilizes the Avalon-MM BEM to access
the Avalon-MM interfaces of the design example components.

m Packet monitors—monitors the transmit and receive datapaths, and displays the
frames in the simulator console.

3.6.3. 10GhE Testhench Files

The following directories contain the 10GbE testbench files which are in clear text:

m 10GbE MAC and XAUI PHY testbench—<ip library>/ethernet/
altera_eth_10g_design_example/altera_eth_10g_mac_xaui/testbench

m 10GbE MAC and 10GBASE-R PHY testbench— <ip library>/ethernet/
altera_eth_10g_design_example/altera_eth_10g_mac_base_r/testbench
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Table 3-5 describes the files that implement the testbench.

Table 3-5. Testhench Files

File Name

Description

avalon_bfm_wrapper.sv

A wrapper for the Avalon BFMs that the avalon_driver.sv file
uses.

avalon_driver.sv

A SystemVerilog HDL driver that utilizes the BFMs to exercise
the transmit and receive path, and access the Avalon-MM
interface.

avalon_if_params_pkg.sv

A SystemVerilog HDL testbench that contains parameters to
configure the BFMs. Because the configuration is specific to
the DUT, you must not change the contents of this file.

avalon_st_eth_packet_monitor.sv

A SystemVerilog HDL testbench that monitors the Avalon-ST
transmit and receive interfaces.

eth_mac_frame.sv

A SystemVerilog HDL class that defines the Ethernet frames.
The avalon_driver.sv file uses this class.

eth_register_map_params_pkg.sv

A SystemVerilog HDL package that maps addresses to the
Avalon-MM control registers.

th_run.tel

A Tcl script that starts a simulation session in the ModelSim
simulation software. Not applicable for Stratix VV design.

th_run_sv.tcl

A Tcl script that starts a simulation session in the ModelSim
simulation software for Stratix VV design only.

th.sv

The top-level testbench file. This file includes the customized
10GbE MAC which is the device under test (DUT), a client
packet generator, and a client packet monitor along with
other logic blocks. Not applicable for Stratix V design.

th_sv.sv

The top-level testbench file for Stratix VV design only. This file
includes the customized 10GbE MAC which is the device
under test (DUT), a client packet generator, and a client
packet monitor along with other logic blocks.

wave.do

A signal tracing macro script to be used with the ModelSim
simulation software to display testbench signals.
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3.6.4. 10GbhE Testhench Simulation Flow

Upon a simulated power-on reset, each testbench performs the following operations:

1.

3.

Initializes the DUT by configuring the following options via the Avalon-MM
interface:

a. Inthe MAC, enables address insertion on the transmit path and sets the
transmit primary MAC address to EE-CC-88-CC-AA-EE.

b. Inthe TX and RX FIFO (Avalon-ST Single Clock FIFO core), enables drop on
error.

Starts packet transmission. The testbench sends a total of eight packets:
a. 64-byte basic Ethernet frame

b. Pause frame

c. 1518-byte VLAN frame

d. 1518-byte basic Ethernet frame

e. 64-byte stacked VLAN frame

f. 500-byte VLAN frame

g. Pause frame

h. 1518-byte stacked VLAN frame

Ends the transmission and displays the MAC statistics in the transcript pane.

3.6.5. Simulating the 10GbE Testhench with the ModelSim Simulator

To use the ModelSim simulator to simulate the testbench design, follow these steps:

1.

Copy the respective design example directory to your preferred project directory:
altera_eth_10g _mac_xaui or altera_eth_10g_mac_base_r from
<ip library>/ethernet/altera_eth_10g_design_example.

The design example and testbench files are set to read only. Altera recommends
that you turn off the read-only attribute of all design example and testbench files.

Launch the Quartus II software and open the top.v file from the project directory.

Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu and then selecting Tcl Console. In the Quartus II Tcl Console window,
type the following command to set up the project environment:

source setup proj.tcl+

Launch Qsys from the Tools menu and open altera_eth_10g_mac_base_r.qsys or
altera_eth_10g_mac_xaui.qsys in the File menu.

For the 10GbE MAC with XAUI design example, the default setting of the XAUI
PHY is Hard XAUI. Follow these steps if you want to set the PHY to Soft XAUI:

a. Double-click the XAUI PHY module to open the parameter editor.
b. On the General Options tab, select Soft XAUI for XAUI Interface Type.

On the Generation tab, select Verilog simulation model.
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8. Click Generate to generate the system.Launch the ModelSim simulator software.

9. Change the working directory to <project directory>/<design example
directory>/testbench in the File menu.

10. Run the following command to set up the required libraries, compile the
generated IP Functional simulation model, and exercise the simulation model with
the provided testbench:

do tb_run.tcl#¢

The ModelSim transcript pane in Main window displays messages from the
testbench reflecting the current task being performed.

Upon a successful simulation, the simulator displays the following RX Statistics
and TX Statistics:

framesOK = 8

framesErr = 0
framesCRCErr = 0
octetsOK = 5138
pauseMACCtrlFrames = 2
ifErrors = 0
unicastFramesOK = 4
unicastFramesErr = 0
multicastFramesOK = 1
multicastFramesErr = 0
broadcastFramesOK = 1
broadcastFramesErr = 0
etherStatsOctets = 5310
etherStatsPkts = 8
etherStatsUndersizePkts = 0
etherStatsOversizePkts = 0
etherStatsPkts640ctets = 4
etherStatsPkts65t0l270ctets = 0
etherStatsPktsl28to2550ctets = 0
etherStatsPkts256to5110ctet = 1
etherStatsPkts512t010230ctets =
etherStatsPktsl1024t0l15180ctets =
etherStatsPktsl5190toXOctets = 0
etherStatsFragments = 0
etherStatsJabbers = 0
etherStatsCRCErr = 0
unicastMACCtrlFrames = 1
multicastMACCtrlFrames
broadcastMACCtrlFrames =

0
3

HHHFHHFHAHFHHHFHFHFEHFHHHFHFHFHHHHFHHFHFHF
1]
[y

|
o

3.6.6. Enabling Local Loopback

You can turn on local loopback to verify the functionality of the MAC during
simulation. Follow these steps to enable local loopback:

1. Open the tb.sv file.

2. Insert the command U AVALON DRIVER.avalon mm csr wr (offset,value) where
offset is the sum of the base address of the loopback module and the register offset,
and value is the value to write to the register.

3. Set value to 1 to enable local loopback; 0 to disable it. Altera recommends that you
insert the command after the command that configures the RX FIFO. For example,
the following code segment enables local loopback:
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// Configure the RX FIFO
U_AVALON DRIVER.avalon mm_csr wr (RX_FIFO DROP_ON_ERROR ADDR,RX FIFO DROP_ON ERROR) ;

// Read the configured registers
U AVALON DRIVER.avalon mm csr rd(RX FIFO DROP ON_ERROR ADDR, readdata) ;
$display ("RX FIFO Drop on Error Enable = %0d", readdatal0]) ;

U AVALON DRIVER.avalon mm csr wr(32'h948, 1)

4. Run the following command again to reconfigure the loopback module, set up the
required libraries, compile the generated IP Functional simulation model, and
exercise the simulation model:

do tb_run.tcl#¢

3.6.7. 10GbE Simulation Timing Diagrams

Figure 3-4 shows the reset and initial configuration sequence. The first read or write
transaction must be at least one clock cycle after the csr_reset_reset_n signal
completes.

Figure 3-4. Reset and Configuration

csr_reset_reset_n ’

csr_address [18:0] | 40084 |

csr_read

csr_readdata [31:0] X

csr_write / \

csr_writedata [31:0] J 00000002

csr_waitrequest
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Figure 3-5 shows the transmission of the first 60-byte frame upon a successful reset
and initial configuration. The same frame is looped back to the receive datapath.

Figure 3-5. Frame Transmission and Reception
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3.7. 10GhE Design Example Compilation and Verification in Hardware

Figure 3-6 shows the components in the top-level file provided with the 10GbE
design example.

Figure 3-6. 10GhE Top-Level Components

Altera Development Board

Address AU/ Remote
Swapper Avalon-ST out 10GBASE-R Partner

A
A

The address swapper swaps the destination address and source address in the receive
frame before sending the frame onto the transmit path. You must connect the DUT—
design example—to a remote partner that generates, transmits, and receives frames.

3.7.1. Compiling the 10GbE Design

You can use the Quartus II software to compile the design example and program the
targeted Altera device after a successful compilation.

Follow these steps to compile the design and program the device:

1. Copy the respective design example directory to your preferred project directory:
altera_eth_10g_mac_xaui or altera_eth_10g_mac_base_r from
<ip library>/ethernet/altera_eth_10g_design_example.

2. Launch the Quartus II software and open top.v from the project directory.

3. Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu then clicking Tcl Console. In the Quartus II Tcl Console window, type
the following command to set up the project environment:

source setup proj.tcl+
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10.
11.

Load the pin assignments and I/O standards for the development board:

m  For the 10GbE MAC with XAUI PHY design example, type the following
command:

source setup SIVGX230C2ES.tcl+

This command assigns the XAUI serial interface to the pins that are connected
to the HSMC Port A of the Stratix IV GX development board.

m  For the 10GbE MAC with 10BASE-R design example, type the following
command:

source setup EP4S100G2F40I1.tcl¢

This command assigns the 10GBASE-R serial interface to the pins that are
connected to the SMA connectors (J38 to J41) of the Stratix IV GT development
board.

“ =@ For more information about the development boards, refer to the respective

reference manuals: Stratix IV GX Development Kit Reference Manual or
Transceiver Signal Integrity Development kit, Stratix IV GT Edition Reference
Manual.

Launch Qsys from the Tools menu and open altera_eth_10g_mac_base_r.qsys or
altera_eth_10g_mac_xaui.qsys.

For the 10GbE MAC with XAUI PHY design example, the default setting of the
PHY is Hard XAUL Follow these steps if you want to set the PHY to Soft XAUI:

a. Double-click the XAUI PHY module to open the parameter editor.

b. On the General Options tab, select Soft XAUI for XAUI Interface Type.
Click Save on the File menu.

On the Generation tab, turn on Create Synthesis RTL Files.

Click Generate to generate the system.

Click Start Compilation on the Processing menu to compile the design example.

Upon a successful compilation, click Programmer on the Tools menu to program
the device.

For more information about device programming, refer to Quartus II Programmer in
volume 3 of the Quartus II Handbook.

If you are not using the Stratix IV GX FPGA development board or the Transceiver
Signal Integrity development board, Stratix IV GT Edition, modify setup_proj.tcl and
setup_SIVGX230C2ES.tcl or setup_EP4S100G2F40I1.tcl to suit your hardware.
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3.7.2. Verifying the 10GhE Design in Hardware

After programming the targeted Altera device, follow these steps to verify your
design and collect the statistics:

1.
2.

Copy the csr_scripts directory to the design example directory.

Launch Qsys and access the System Console by clicking System Console on the
Tools menu.

Change the working directory to <project directory>/csr_scripts.

Type the following command to configure the design example:

source config.tcl#

Start frame transmission on your remote partner to exercise the datapaths.
Type the following command to read and view the statistics:

source show stats.tcl¢

[l=~ The config.tcl and show_stats.tcl scripts support only one USB-Blaster
connection.

3.7.3. Debugging

You can use the system console to perform the following tasks for debugging
purposes:

m Reconfigure the design example components and retrieve the registers during

runtime by following these steps:
a. Create a new Tcl script.

b. Add the following commands:
source common.tcl

# establishes the connection
open_jtag

# use rd32 to retrieve the register wvalue

# base address = base address of the component
# offset = byte offset of the register

rd32 <base address> 0 <offset>

# use wr32 to configure the register

# base address = base address of the component
# offset = byte offset of the register

# value = value to be written to the register
wr32 <base address> 0 <offset> <value>

# closes the connection
close_jtag

Save and close the Tcl script and type the following command:
source <script>.tcl¥
Retrieve and view the statistics counters by typing the following command:

source show stats.tcl*
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®m  Turn on the line loopback to verify the functionality of the XAUI/10GBASE-R
PHY by following these steps:

a. Edit the script config.tcl.

b. Add the command write line loopback (value) immediately after the
command that establishes the JTAG connection. Set the argument value, to 1 to
enable line loopback; 0 to disable line loopback. For example, the following
codes enable line loopback:

open jtag
write line loopback 1

c. Save and close config.tcl, and type the following command:

source config.tcl#

=@ TFormore information on the System Console, refer to Analyzing and Debugging Designs
with the System Console in volume 3 of the Quartus 1I Handbook.

3.7.4. 10GbE Design Transmit and Receive Latencies
Altera uses the following definitions for the transmit and receive latencies:

m Transmit latency is the number of clock cycles the MAC function takes to transmit
the first byte on the network-side interface (XGMII SDR) after the bit was first
available on the Avalon-ST interface.

m Receive latency is the number of clock cycles the MAC function takes to present
the first byte on the Avalon-ST interface after the bit was received on the
network-side interface (XGMII SDR).

Table 3—-6 shows the transmit and receive nominal latencies of the design example.

Table 3-6. Transmit and Receive Latencies of the 10GhE Design Example

Latency (Clock Cycles) (1) (2)
Configuration Transmit Receive
(with respect to TX clock) | (with respect to RX clock)

MAC and Ethernet loopback 10 13
Dual Core FIFO 6 6
Single Core FIFO 10 10
Soft XAUI PHY 41 (3)
Hard XAUI PHY 24 (3)
Soft 10GBASE-R PHY 56 (3)

Notes to Table 3-6:
(1) The clocks in all domains are running at the same frequency.

(2) The latency values are based on the assumption that there is no backpressure on the Avalon-ST TX and RX
interface.

(3) Total latency for both transmit and receive in this design example targeting the Stratix IV device family.
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3.7.5. 10GhE Design Performance and Resource Utilization

Table 3-7 provides the estimated performance and resource utilization of the 10GbE
design example obtained by compiling the design with the Quartus II software
targeting the Stratix IV GX (EP4SGX230KF40C2ES) device with speed grade —2.

Table 3-7. Stratix IV Performance and Resource Utilization

Compones | COMplnal | Wemry | el | MmOk | gy ik
MAC 4,054 36 4,710 6 >156.25
Loopback 293 0 182 4 >156.25
RX SC FIFO 231 0 210 5 >156.25
TX SC FIFO 212 0 210 4 >156.25
Hard XAUI PHY 1,892 0 1,215 0 >156.25
MDIO 116 0 133 0 >156.25
JTAG Master 523 0 440 1 >156.25
Address Swapper 66 0 71 0 >156.25
Qsys Fabric 993 2 1,018 0 >156.25
Total Resource Utilization 7,840 38 8,019 20 >156.25

Table 3-8 provides the estimated performance and resource utilization of the 10GbE
design example obtained by compiling the design with the Quartus II software
targeting the Cyclone V GX (5CGXFC7D6F31C6) device with speed grade —6.

Table 3-8. Cyclone V Performance and Resource Utilization

Components Combinational | Logic Registers Me'}‘ﬁ%g;""" fynx (MH2)
MAC 4,417 5,464 6 >156.25
Loopback 291 199 4 >156.25
RX SC FIFO 242 231 4 >156.25
TX SC FIFO 215 232 4 >156.25
MDIO 118 144 0 >156.25
Soft XAUI 1,642 1,750 3 >156.25
JTAG Master 537 468 1 >156.25
Address Swapper 66 71 0 >156.25
Qsys Fabric 444 688 1 >156.25
Total Resource Utilization 7,972 9,247 23 >156.25
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Table 3-9 provides the estimated performance and resource utilization of the 10GbE

design example obtained by compiling the design with the Quartus II software
targeting the Stratix V GX (5SGXEA7N2F40C2ES) device with speed grade 2.

Table 3-9. Stratix V Performance and Resource Utilization

Components com:illlla_;siunal Memory ALUTs | Logic Registers Menm;lgluck fmax (MHz)
MAC 4110 17 5,212 4 >156.25
Loopback 290 0 187 4 >156.25
RX SC FIFO 234 0 236 2 >156.25
TX SC FIFO 220 0 246 2 >156.25
MDIO 115 0 146 0 >156.25
10GBASE-R PHY 112 0 114 0 >156.25
JTAG Master 519 0 508 1 >156.25
Address Swapper 66 0 74 0 >156.25
Qsys Fabric 441 0 679 0 >156.25
Total Resource Utilization 6,107 0 7,402 13 >156.25

Table 3-10 provides the estimated performance and resource utilization of the design
example with the IEEE 1588v2 feature enabled, obtained by compiling the design with
the Quartus II software targeting a Stratix V (5SGTMC5K2F40C2) device with speed

grade -2.
Table 3-10. Stratix V Performance and Resource Utilization with IEEE 1588v2 Feature
Combhinational . . Memory Block
Components ALUTs Logic Registers (M20K) DSP Block fmax (MHz)

MAC 6,822 7,459 10 2 >156.25
Loopback 291 264 4 0 >156.25
10GBASE-R PHY 1,066 1,675 6 0 >156.25
Time-of-Day (ToD) Clock 812 2,268 0 0 >156.25
Transceiver 1,245 871 6 0 >156.25
Reconfiguration

Qsys Fabric 83 73 0 >156.25
Total Resource Utilization 10,319 12,610 26 >156.25
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This section describes the 10GbE MAC with IEEE 1588v2 design example, testbench
and its components.

=~ 10GBASE-R PHY does not support Stratix III devices.

4.1. Software Requirements

Altera uses the following software to test the 10GbE with IEEE 1588v2 design example
and testbench:

B  Quartus II software 13.1

m ModelSim-SE 10.0b or higher
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4.2. 10GhE with IEEE 1588v2 Design Example Components

You can use the 10GbE MAC IP core design example to simulate a complete 10GbE
with IEEE 1588v2 design in a simulator. You can compile the design example using
the Quartus II software and program the targeted Altera device after a successful

compilation.
Figure 4-1 shows the block diagram of the 10GbE with IEEE 1588v2 design example.

Figure 4-1. 10GbE with IEEE 1588v2 Design Example Block Diagram
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The 10GbE with IEEE 1588v2 design example comprises the following components:

m  Altera Ethernet 10G design example—the default 10G design example that has the
following settings:

m 10GbE Ethernet MAC—the MAC IP core with IEEE 1588v2 option enabled.
m  10GBASE-R PHY—the PHY IP core with IEEE 1588v2 option enabled.

m Ethernet Loopback—the loopback module provides a mechanism for you to
verify the functionality of the MAC and PHY.

m  MDIO and FIFO features turned off.

m Transceiver Reconfiguration Controller—dynamically calibrates and reconfigures
the features of the PHY IP cores.

m Ethernet Packet Classifier—decodes the packet type of incoming PTP packets and
returns the decoded information to the 10GbE Ethernet MAC.

m Ethernet Time-of-Day (ToD) Clock—provides 64-bits and/or 96-bits time-of-day to
TX and RX of 10GbE Ethernet MAC.

m Pulse Per Second Module—returns pulse per second (pps) to user.

m  Avalon MM Master Translator—provides access to the registers of the following
components through the Avalon-MM interface:

m MAC and Ethernet Loopback
m Transceiver Reconfiguration Controller

m ToD

For more information about ToD clock, refer to Appendix B, Time-of-Day (ToD)
Clock; and for more information about Packet Classifier, refer to Appendix C, Packet
Classifier.

4.2.1. Base Addresses

Table 4-1 lists the design example components that you can reconfigure to suit your
verification objectives. To reconfigure the components, write to their registers using
the base addresses listed in the table and the register offsets described in the
components' user guides.

Table 4-1. Base Addresses of 10GbE with IEEE 1588v2 Design Example Components

Component Base Address
MAC and Ethernet Loopback 0x00000
Transceiver Reconfiguration Controller 0x80400
Time of Day Clock 0x81000

This design example uses a 19-bit width address bus to access the base address of
components other than the MAC.
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4.3. 10GbE with IEEE 1588v2 Design Example Files

Table 4-2 shows the directory structure for the 10GbE with IEEE 1588v2 design
examples and testbenches.

Figure 4-2. 10GbE with IEEE 1588v2 Design Example Folders

<ip_lib>/ethernet/altera_eth_10g_design_example

altera_eth_10g_mac_hase_r_1588

testhench

Table 4-2 lists the files in the ..\altera_eth_10g_mac_base_r_1588 directory.

Table 4-2. 10GbE with IEEE 1588v2 Design Example Files

File Name Description

The top-level entity file of the design example for
verification in hardware.

The Quartus Il SDC constraint file for use with
the TimeQuest timing analyzer.

A Qsys file for the 10GbE MAC and 10GBASE-R
altera_eth_10g_mac_base_r_1588.qsys PHY design example with IEEE 1588v2 option
enabled.

altera_eth_10g_mac_base_r_1588_top.v

altera_eth_10g_mac_base_r_1588_top.sdc

4.4. Creating a New 10GbE with IEEE 1588v2 Design

You can use the Quartus II software to create a new 10GbE with IEEE 1588v2 design.
Altera provides a Qsys design example file that you can customize to facilitate the
development of your 10GbE with IEEE 1588v2 design.

To create the design, perform the following steps:

1. Launch the Quartus II software and open the
altera_eth_10g_mac_base_r_1588_top.v file from the project directory.

2. Launch Qsys from the Tools menu and open the
altera_eth_10g_mac_base_r_1588.qsys file. By default, the design example targets
the Stratix V device family. To change the target device family, click on the Project
Settings tab and select the desired device from the Device family list.

3. Turn off the additional module under the Use column if your design does not
require it. This action disconnects the module from the 10GbE with IEEE 1588v2
system.

Double-click on eth_10g_design_example_0 to launch the parameter editor.

Specify the required parameters in the parameter editor.

Click Finish.

N e

On the Generation tab, select either a Verilog HDL or VHDL simulation model
and make sure that the Create HDL design files for synthesis option is turned on.
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8. Click Generate to generate the simulation and synthesis files.

4.5. 10GbE with IEEE 1588v2 Testhench

Altera provides testbench for you to verify the 10GbE with IEEE 1588v2 design
example. The following sections in this document describe the testbench, its
components, and use.

4.5.1. 10GhE with IEEE 1588v2 Testhench

The testbenches operate in loopback mode. Figure 4-3 shows the flow of the packets.

Figure 4-3. Testhench

Testbench
Ethernet
Y Packet
Avalon-MM Monitor
Control A
Register Avalon-MM
\ 4
Avalon-ST
Transmit
Frame Avalon-ST
enereter DUT Loopback
on XGMII
Avalon-ST <
Receive L Avalon-ST
Frame ‘
Monitor
\4
avalon_bfm_wrapper.sv Ethernet
Packet
Avalon Driver Monitor

4.5.2. 10GbE with IEEE 1588v2 Testhench Components

The testbenches comprise the following modules:
m Device under test (DUT)—the design example.

m Avalon driver—uses Avalon-ST bus functional models (BFMs) to exercise the
transmit and receive paths. The driver also utilizes the Avalon-MM BFM to access
the Avalon-MM interfaces of the design example components.

m Packet monitors—monitors the transmit and receive datapaths, and displays the
frames in the simulator console.
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4.5.3. 10GbE with IEEE 1588v2 Testhench Files

The <ip

library>/ ethernet/altera_eth_10g_design_example/altera_eth_10g_mac_base_r_1588
/testbench directory contains the testbench files.

Table 4-3 describes the files that implement the 10GbE with IEEE 1588v2 testbench.

Table 4-3. 10GhE with IEEE 1588v2 Testhench Files

File Name

Description

avalon_bfm_wrapper.sv

A wrapper for the Avalon BFMs that the avalon_driver.sv file
uses.

avalon_driver.sv

A SystemVerilog HDL driver that utilizes the BFMs to exercise
the transmit and receive path, and access the Avalon-MM
interface.

avalon_if_params_pkg.sv

A SystemVerilog HDL testbench that contains parameters to
configure the BFMs. Because the configuration is specific to
the DUT, you must not change the contents of this file.

avalon_st_eth_packet_monitor.sv

A SystemVerilog HDL testbench that monitors the Avalon-ST
transmit and receive interfaces.

default_test_params_pkg.sv

A SystemVerilog HDL package that contains the default
parameter settings of the testbench.

eth_mac_frame.sv

A SystemVerilog HDL class that defines the Ethernet frames.
The avalon_driver.sv file uses this class.

eth_register_map_params_pkg.sv

A SystemVerilog HDL package that maps addresses to the
Avalon-MM control registers.

ptp_timestamp.sv

A SystemVerilog HDL class that defines the timestamp in the
testbench.

th_run_simulation.tcl

A Tcl script that starts a simulation session in the ModelSim
simulation software.

th_testcase.sv

A SystemVerilog HDL testbench file that controls the flow of
the testbench.

The top-level testhench file. This file includes the customized
10GbE MAC, which is the device under test (DUT), a client

th_top.sv packet generator, and a client packet monitor along with
other logic blocks.
wave.do A signal tracing macro script for use with the ModelSim

simulation software to display testbench signals.
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4.5.4. 10GhE with IEEE 1588v2 Testhench Simulation Flow

Upon a simulated power-on reset, each testbench performs the following operations:

1.

Initializes the DUT by configuring the following options through the Avalon-MM
interface:

m Configures the MAC. In the MAC, enables address insertion on the transmit
path and sets the transmit and receive primary MAC address to EE-CC-88-CC-
AA-EE. Also enables CRC insertion on transmit path.

m Configures Timestamp Unit in the MAC, by setting periods and path delay
adjustments of the clocks.

m Configures ToD clock by loading a predefined time value.
m  Configures clock mode of Packet Classifier to Ordinary Clock mode.

Starts packet transmission with different clock mode. The testbench sends a total
of four packets:

m  64-byte basic Ethernet frames

m 1-step PTP Sync message over Ethernet

m 1l-step PTP Sync message over UDP/IPv4 with VLAN tag

m 2-step PTP Sync message over UDP/IPv6 with stacked VLAN tag

Configures clock mode of Packet Classifier to End-to-end Transparent Clock
mode.

Starts packet transmission. The testbench sends a total of three packets:
m 1-step PTP Sync message over Ethernet

m 2-step PTP Sync message over UDP/IPv4 with VLAN tag

m 1-step PTP Sync message over UDP/IPv6 with stacked VLAN tag

Ends the transmission.

4.5.5. Simulating 10GbE with IEEE 1588v2 Testhench with ModelSim

Simulator

To use the ModelSim simulator to simulate the testbench design, follow these steps:

1.

Copy the respective design example directory to your preferred project directory:
altera_eth_10g_mac_base_r_1588 from
<ip library>/ethernet/altera_eth_10g_design_example.

Launch Qsys from the Tools menu and open the
altera_eth_10g_mac_base_r_1588.qgsys file.

On the Generation tab, select either a Verilog HDL or VHDL simulation model.
Click Generate to generate the simulation and synthesis files.

Run the following command to set up the required libraries, to compile the
generated IP Functional simulation model, and to exercise the simulation model
with the provided testbench:

do tb run simulation.tcl#
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This section describes the 1G/10GbE MAC with Backplane Ethernet Backplane
Ethernet 10GBASE-KR PHY design example, the testbench, and its components. You
can configure the Backplane Ethernet 10GBASE-KR PHY IP to the following modes:

m Backplane-KR mode to interface with copper backplane
m 1G/10Gb Ethernet mode to interface with optical SFP+ modules or copper PHY

devices

I'=~ Backplane Ethernet I0GBASE-KR PHY only supports Arria V GZ and Stratix V
devices.

5.1. Software and Hardware Requirements

Altera uses the following hardware and software to test the 1G/10GbE design
example and testbench:

m Altera Complete Design Suite 13.0

m Backplane Ethernet 10GBASE-KR PHY

m  Transceiver Signal Integrity Development Kit, Stratix V GX Edition
m ModelSim-AE 6.6¢c, ModelSim-SE 6.6¢ or higher

=~ The 1G/10GbE mode is only supported in the production silicon version of the
development board.

“ e For more information about the development kit, refer to Transceiver Signal Integrity

Development Kit, Stratix V GX Edition User Guide.
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5.2. 1G/10GbE Design Example Components

You can use the 1G/10GbE MAC IP core design example to simulate a complete
1G/10GbE design in an Altera FPGA. You can compile the design example using the
simulation files generated by the Quartus II software and program the targeted Altera
device after a successful compilation.

Figure 5-1 shows the block diagram of a two-channel 1G/10GbE design example.

Figure 5-1. Two-Channel 1G/10GhE Design Example Block Diagram
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Figure 5-2 shows the clocking scheme for the design example.

Figure 5-2. 1G/10GhE Design Example Clocking Scheme
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The 1G/10GbE design example comprises the following components:

m 1G/10GbE Ethernet MAC—the MAC IP core with default settings. This IP core

includes memory-based statistics counters.

Backplane Ethernet 10GBASE-KR PHY—the PHY IP core operating as either

1000BASE-X PHY or 10GBASE-R PHY.

Reconfiguration Bundle—comprises the reconfiguration controller that switches

the speed between 1 Gbps and 10 Gbps, and the management ROM that stores

MIF information for 1/10GbE PHY or HSSI or hard PCS. This block arbitrates the
access to the reconfiguration controller and requests the reconfiguration controller
to start streaming MIF information.

Single-Clock FIFO—Avalon-ST Single-Clock RX and TX FIFO cores that buffer

receive and transmit data between the MAC and the client. These FIFO buffers are

64 bits wide and 2048 bits deep. The Single-Clock FIFO operates in store and

forward mode, and you can configure it to provide packet-based flushing when an

error occurs.
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=~ To enable the Avalon-ST Single-Clock FIFO to operate in cut through mode,
turn off the Use store and forward parameter in the Avalon-ST Single
Clock FIFO parameter editor.

m PHY IP Reset Controller—configurable IP core that you can use to reset the
transceivers. Refer to the Transceiver PHY Reset Controller IP Core chapter in the
Altera Transceiver PHY IP Core User Guide for more information.

m Configure Reconfiguration Block—provides the Avalon-MM interface to drive the
reconfiguration bundle component to switch speed.

"=~ This component is required only if the automatic speed detection parameter
in the Backplane Ethernet 10GBASE-KR PHY is not enabled.

5.2.1. Reconfiguration Bundle Parameters

Table 5-1 lists the parameters for the reconfiguration bundle block.

Table 5-1. Reconfiguration Bundle Parameters

Parameter

Description

PMA RD AFTER WRITE

Always set this parameter to 0.

The number of channels instantiated for the Backplane Ethernet

CHANNELS 10GBASE-KR PHY IP.
The number of PLLs.
PLLS If you turn on the 1G mode in the Backplane Ethernet 10GBASE-KR

PHY [P, this value will be two times the value of the CHANNELS
parameter.

SYNTH 1588 1G

Set this parameter to 1 if you use 1G mode with the 1588 options
turned on in the Backplane Ethernet 10GBASE-KR PHY IP.

SYNTH 1588 10G

Set this parameter to 1 if you use 10G mode with the 1588 options
turned on in the Backplane Ethernet 10GBASE-KR PHY IP.

KR _PHY SYNTH LT

Set this parameter to 1 if the Enable Link Training (LT) option is
turned on in the Backplane Ethernet 10GBASE-KR PHY IP.

KR_PHY SYNTH AN

Set this parameter to 1 if the Enable Auto Negotiation (AN) option is
turned on in the Backplane Ethernet 10GBASE-KR PHY IP.

KR _PHY SYNTH GIGE

Set this parameter to 1 if you use 1G mode in the Backplane Ethernet
10GBASE-KR PHY IP.

5.2.2. Base Addresses

Table 5-2 lists the design example components that you can configure to suit your
verification objectives. To configure the components, write to their registers using the
base addresses listed in the table and the register offsets described in the components'

user guides.

Table 5-2. Base Addresses of 1G/10GhE Design Example Components

Component Base Address
1G/10GbE MAC Channel 0 0x00000
1G/10GbE MAC Channel 1 0x20000

10-Gbps Ethernet MAC MegaCore Function User Guide
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Table 5-2. Base Addresses of 1G/10GhE Design Example Components

Component Base Address
10GBASE-KR Channel 0 0x80000
10GBASE-KR Channel 1 0x80800
Configure Reconfiguration Channel 0 0x80400
Configure Reconfiguration Channel 1 0x80500
RX FIFO (Avalon-ST Single-Clock FIFQ) Channel 0 0x10400
TX FIFO (Avalon-ST Single-Clock FIFO) Channel 0 0x10600
RX FIFO (Avalon-ST Single-Clock FIFQ) Channel 1 0x30400
TX FIFO (Avalon-ST Single-Clock FIFO) Channel 1 0x30600

[l=~ This design example uses a 19-bit width address bus to access the base address of

components other than the MAC.

“% e For more information about the I0GBASE-KR, refer to the IT0GBASE-KR PHY IP Core
chapter in the Altera Transceiver PHY IP Core User Guide.

5.3. 1G/10GbE Design Example Files

Figure 5-3 shows the directory structure for the 1G/10GbE design examples and
testbenches.

Figure 5-3. 1G/10GhE Design Example Folders

<ip_lib>/ethernet/altera_eth_10g_design_example

altera_eth_10g_mac_base_kr

testhench

reconfig

Table 5-3 lists the files in the ..\altera_eth_10g_mac_base_kr directory.

Table 5-3. 1G/10GhE Design Example Files

File Name Description

The top-level entity file of the design example for
verification in hardware.

The Quartus Il SDC constraint file for use with
the TimeQuest timing analyzer.

A Tcl script that creates a new Quartus Il project
setup_proj.tcl and sets up the project environment for your
design example.

A Qsys file for the 1G/10GbE MAC and 10G
altera_eth_10g_mac_base_kr.qsys BASE-KR PHY design example with the
Quartus Il software targeting the Stratix V device.

A top-level entity file for the transceiver
reconfiguration controller IP.

altera_eth_10g_mac_base_kr_top.v

altera_eth_10g_mac_base_kr_top.sdc

reconfig.v
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5.4. Creating a New 1G/10GbE Design

You can use the Quartus II software to create a new 1G/10GbE design. Altera
provides a Qsys design example file that you can customize to facilitate the
development of your 1G/10GbE design.

To create the design, perform the following steps:

1.

Launch the Quartus II software and open the altera_eth_10g_mac_base_kr_top.v
file from the project directory.

Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu and then selecting Tcl Console. In the Quartus II Tcl Console window,
type the following command to set up the project environment and load the
necessary pins assignment for Stratix V GX signal integrity development kit
board:

source setup proj.tcl¢

“ e For more information about the development kit, refer to Signal Integrity
Development Kit, Stratix V GX Edition User Guide.

Launch Qsys from the Tools menu and open the
altera_eth_10g_mac_base_kr.qsys file.

L=~ At this point you can edit the settings to suit your design using the
parameter editor.
Click Finish.

On the Generation tab, select either a Verilog HDL or VHDL simulation model
and make sure that the Create HDL design files for synthesis option is turned on.

Click Generate to generate the simulation and synthesis files.

Launch the MegaWizard Plug-in Manager from the Tools menu. Select Edit an
existing custom megafunction variation and regenerate reconfig.v from the
reconfig folder.

Click Finish.

5.5. 1G/10GhE Testhench

Altera provides testbench for you to verify the 1G/10GbE design example. The
following sections describe the testbench, its components, and use.

5.5.1. 1G/10GhbE Testhench

The testbench operates in loopback mode. Figure 5-4 shows the flow of the packets in
the design example.
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Figure 5-4. 1G/10GhE Testhench Block Diagram
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5.5.2. 1G/10GhE Testhench Components

The testbenches comprise the following modules:

m Device under test (DUT)—the design example.

B Avalon driver—uses Avalon-ST master bus functional models (BFMs) to exercise
the transmit and receive paths. The driver also uses the Avalon-MM master BEM
to access the Avalon-MM interfaces of the design example components.

m Packet monitors—monitors the transmit and receive datapaths, and displays the
frames in the simulator console.

5.5.3. 1G/10GbE Testhench Files

The <ip library>/ ethernet/altera_eth_10g_design_example/testbench directory

contains the testbench files.

Table 54 describes the files that implement the 1G/10GbE testbench.

Table 5-4. 1G/10GbE Testhench Files

File Name

Description

avalon_bfm_wrapper.sv

A wrapper for the Avalon BFMs that the avalon_driver.sv file

uses.

avalon_driver.sv

A SystemVerilog HDL driver that utilizes the BFMs to exercise
the transmit and receive path, and access the Avalon-MM
interface.
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Table 5-4. 1G/10GbE Testhench Files

File Name Description

A SystemVerilog HDL testbench that contains parameters to
avalon_if_params_pkg.sv configure the BFMs. Because the configuration is specific to
the DUT, you must not change the contents of this file.

A SystemVerilog HDL testbench that monitors the Avalon-ST
transmit and receive interfaces.

A SystemVerilog HDL class that defines the Ethernet frames.
The avalon_driver.sv file uses this class.

A SystemVerilog HDL package that maps addresses to the
Avalon-MM control registers.

A Tcl script that starts a simulation session in the ModelSim

avalon_st_eth_packet_monitor.sv

eth_mac_frame.sv

eth_register_map_params_pkg.sv

th_run.tcl simulation software.
The top-level testbench file. This file includes the customized
th.sv 1G/10GbE design example, which is the device under test
’ (DUT), a client packet generator, and a client packet monitor
along with other logic blocks.
wave.do A signal tracing macro script for use with the ModelSim

simulation software to display testbench signals.
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5.5.4. 1G/10GbE Testhench Simulation Flow

The 1G/10GDbE testbench provides two modes for simulation:
m 1G/10Gb Ethernet mode

m Backplane-KR mode

By default the testbench runs in 1G/10Gb Ethernet mode.

To switch to backplane-KR mode, open the tb.sv file and specify the
MODE 1G10G_KR BAR parameter to 0.

5.5.4.1. 1G/10Gh Ethernet Mode

Upon a simulated power-on reset, the testbench performs the following operations:

1. Initializes the DUT by configuring the following options through the Avalon-MM
interface:

a. Changes both channel 1 and channel 0 to be operating speed at 10 Gbps.

d.

2. Starts packet transmission. The testbench sends a total of eight packets:

Configures the MAC. In the MAC, enables address insertion on the transmit
path and sets the transmit primary MAC address to EE-CC-88-CC-AA-EE.

In the TX and RX FIFO buffers (Avalon-ST Single Clock FIFO core), enables

drop on error.

Waits for both the MAC and PHY to be ready to receive data.

a. Three 64-byte basic Ethernet frames

e.

f.

1518-byte VLAN frame
1518-byte basic Ethernet frame

. 64-byte stacked VLAN frame

500-byte VLAN frame
1518-byte stacked VLAN frame

3. Displays the MAC statistics in the transcript panel.

4. Changes the operating speed for both channels.

a.
b.
C.

5. Starts packet transmission. The testbench sends a total of eight packets:

Changes the operating speed for both channels to 1 Gbps.
Disables clause 37 auto-negotiation for both channels.

Waits for both the MAC and PHY to be ready to receive data

a. Three 64-byte basic Ethernet frames
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6.

Displays the MAC statistics in the transcript panel.

5.5.4.2. Backplane-KR Mode

To run backplane-KR mode in simulation, perform the following steps:

1.

2.
3.

Open the altera_eth_10g_mac_base_kr.qsys file and edit the following
10GBASE-KR PHY instances of channels 1 and 0:

m [P variant = Backplane-KR

m  Turn on Enable Automatic Speed Detection.

m Turn on Enable Auto-negotiation.

m Regenerate the Qsys system.

Change the default setting to backplane-KR mode.

Run simulation.

Upon a simulated power-on reset, the testbench performs the following operations:

1.

3.

Initializes the DUT by configuring the following options via the Avalon-MM
interface:

a. Configures the MAC. In the MAC, enables address insertion on the transmit
path and sets the transmit primary MAC address to EE-CC-88-CC-AA-EE.

b. Inthe TX and RX FIFO buffers (Avalon-ST Single Clock FIFO core), enables
drop on error.

c. Checks if auto-negotiation status is completed.

d. Waits for both the MAC and PHY to be ready to receive data.

Starts packet transmission. The testbench sends a total of eight packets:
a. Three 64-byte basic Ethernet frames

b. 1518-byte VLAN frame

c. 1518-byte basic Ethernet frame

d. 64-byte stacked VLAN frame

e. 500-byte VLAN frame

f. 1518-byte stacked VLAN frame

Displays the MAC statistics in the transcript panel.

5.5.5. Simulating the 1G/10GbE Testbench with the ModelSim Simulator

To use the ModelSim simulator to simulate the 1G/10GbE testbench design, perform
the following steps:

1.

Copy the
<ip library>/ethernet/altera_eth_10g_design_example/altera_eth_10g mac_bas
e_kr directory to your preferred project directory.

The design example and testbench files are set to read only. Altera recommends
that you turn off the read-only attribute of all design example and testbench files.
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10.

11.

Launch the Quartus II software and open the altera_eth_10g_mac_base_kr_top.v
file from the project directory.

Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu and then selecting Tcl Console. In the Quartus II Tcl Console window,
type the following command to set up the project environment:

source setup proj.tcl¢

Launch Qsys from the Tools menu and open altera_eth_10g_mac_base_kr.qsys in
the File menu.

On the Generation tab, select Verilog simulation model.

By default, the system will be running in 1G/10Gb Ethernet mode. To run in
backplane-KR mode, edit the following Backplane Ethernet 10GBASE-KR PHY
instances of channels 1 and 0:

m [P variant = Backplane-KR

m  Turn on Enable Automatic Speed Detection.
m  Turn on Enable Auto-negotiation.

Click Generate to generate the system.

Launch the ModelSim simulator software.

Change the working directory to <project directory>/<design example
directory>/testbench in the File menu.

Run the following command to set up the required libraries, compile the
generated IP Functional simulation model, and exercise the simulation model with
the provided testbench:

do tb_run.tcl#¢

By default the system will be running in 1G/10Gb Ethernet mode. To run in
backplane-KR mode, open the tb.sv file and change the MODE_1G10G_KR_BAR
parameter to 0, then run the command.

The ModelSim transcript pane in Main window displays messages from the
testbench reflecting the current task being performed.

Upon a successful simulation, the simulator displays the following RX Statistics
and TX Statistics:

framesOK = 8
framesErr = 0
framesCRCErr = 0
octetsOK = 5142

pauseMACCtrlFrames = 0

#

#

#

#

#

# ifErrors = 0
# unicastFramesOK = 6

# unicastFramesErr = 0

# multicastFramesOK = 1
# multicastFramesErr = 0
#

broadcastFramesOK = 1
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broadcastFramesErr = 0
etherStatsOctets = 5310
etherStatsPkts = 8
etherStatsUndersizePkts = 0

etherStatsOversizePkts = 0

etherStatsPkts640ctets 4

etherStatsPkts65tol270ctets = 0
etherStatsPktsl28to2550ctets = 0
etherStatsPkts256to5110ctet = 1
etherStatsPkts512t0l10230ctets = 0
etherStatsPktsl1024to0l5180ctets = 3
etherStatsPktsl15190toXOctets = 0
etherStatsFragments = 0
etherStatsJabbers = 0
etherStatsCRCErr = 0
unicastMACCtrlFrames = 0

multicastMACCtrlFrames = 0

H+ H O H H H H O H O H O HF HF H O H H O H H H H H

broadcastMACCtrlFrames = 0

=~ The same message will appear twice if you use 1G/10G Ethernet mode
because the system resets the statistic counters after changing the MAC
operating speed.

5.5.6. 1G/10GbE Simulation Timing Diagrams

Figure 5-5 shows the reset and initial configuration sequence. The first read or write
transaction must be at least one clock cycle after the csr reset reset nsignal
completes.

Figure 5-5. Reset and Configuration

csr_reset_reset_n '

csr_address [18:0] X 40084 X

csr_read

csr_readdata [31:0] X

csr_write / \

csr_writedata [31:0] J 00000002

csr_waitrequest
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5.6. 1G/10GbE Design Example Compilation

You can use the Quartus II software to compile the 1G/10GbE design example and
program the targeted Altera device after a successful compilation.

5.6.1. Compiling the 1G/10GbE Design

Perform the following steps to compile the design and program the device:

o=

1.

o ® N o Uk

Copy the
<ip library>/altera_eth_10g_design_example/altera_eth_10g_mac_base_kr
directory to your preferred project directory.

Launch the Quartus II software and open altera_eth_10g_mac_base_kr_top.v
from the project directory.

Open the Quartus II Tcl Console window by pointing to Utility Windows on the
View menu then clicking Tcl Console. In the Quartus II Tcl Console window, type
the following command to set up the project environment and load pin
assignments and I/O standard for the development kit:

source setup proj.tcl+

“ e For more information about the development kit, refer to Signal Integrity

Development Kit, Stratix V GX Edition User Guide.
Launch Qsys from the Tools menu and open altera_eth_10g_mac_base_kr.gsys.
Click Save on the File menu.
On the Generation tab, turn on Create Synthesis RTL Files.
Click Generate to generate the system.
Click Start Compilation on the Processing menu to compile the design example.

Upon a successful compilation, click Programmer on the Tools menu to program
the device.

. Launch the MegaWizard Plug-in Manager. Select Edit an existing custom

megafunction variation and regenerate reconfig.v from the reconfig folder.

If you want to share the PLL clock, connect the pl1_powerdown signal from the reset
controller to the pl1 powerdown signal from different channels of the Backplane
Ethernet 10GBASE-KR PHY IP.

For example, the pl1_powerdown signal from reset controller 0 connects to the
pll_powerdown signal from channel 0 and channel 1 of the Backplane Ethernet
10GBASE-KR PHY IP.

For more information about device programming, refer to Quartus II Programmer in
volume 3 of the Quartus II Handbook.
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5.6.2. 1G/10GbE Design Performance and Resource Utilization

Table 5-5 provides the estimated performance and resource utilization of the
1G/10GbE design example obtained by compiling the design with the Quartus II
software targeting the Stratix V GX (EP5SGXEA7N2F40C2) device with speed grade
-2.

Table 5-5. Stratix V Performance and Resource Utilization

Components ALM Needed A;'::cizl:;:?l Memory Block

1G/10GbE MAC Channel 0 3,272 3,900 9
1G/10GbE MAC Channel 1 3,302 3,891 9
10GBASE-KR Channel 0 547 685 1

10GBASE-KR Channel 1 547 690 1

Reconfiguration Bundle 1,644 1,940 8
JTAG Master 341 424 1

RX FIFO (Avalon-ST Single-Clock FIFO) Channel 0 142 172 2
TX FIFO (Avalon-ST Single-Clock FIFO) Channel 0 140 180 2
RX FIFO (Avalon-ST Single-Clock FIFQ) Channel 1 138 176 2
TX FIFO (Avalon-ST Single-Clock FIFO) Channel 1 139 176 2
Other Components 2,628 3,123 8
Total Resource Utilization 12,840 15,357 45
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This section describes the 10M/100M/1G/10 Gbps Ethernet (10M-10GbE) MAC with
IEEE 1588v2 design example, the testbench, and its components.

6.1. Software and Hardware Requirements

Altera uses the following hardware and software to test the 10M-10GbE MAC with
IEEE 1588v2 design example and testbench:

m  Altera Complete Design Suite 13.0
m Stratix V GX FPGA Development Kit
® ModelSim-SE 10.0b or higher

6.2. 10M-10GbE MAC with IEEE 1588v2 Design Example Components

You can use the 10M-10GbE MAC IP core design example to simulate a complete
10M-10GbE MAC with IEEE 1588v2 design in a simulator. You can compile the design
example using the Quartus II software and program the targeted Altera device after a
successful compilation.

Figure 6-1 shows the block diagram of a 10M-10GbE MAC with IEEE 1588v2 design
example.

L=~ For the purpose of simplification, this diagram shows only one of the two channels in

the design example. Each channel has its own components but they share the
Avalon-MM Master Translator and Reconfiguration Bundle blocks.
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Figure 6-1. 10M-10GbE MAC with IEEE 1588v2 Design Example Block Diagram
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The 10M-10GbE MAC with IEEE 1588v2 design example comprises the following
components:

Altera Ethernet 10M-10GbE design example—the default 1G/10G design that has
the following parameter settings:

m  10M-10GbE Ethernet MAC—the MAC IP core with IEEE 1588v2 option
enabled.

m  MDIO and FIFO features turned off.

Backplane Ethernet 10GBASE-KR PHY—the PHY IP core with IEEE 1588v2 option
enabled.

Reconfiguration Bundle—comprises the reconfiguration controller that switches
the speed between 1 Gbps and 10 Gbps, and the management ROM that stores
MIF information for 1/10GbE PHY or HSSI or hard PCS. This block arbitrates the
access to the reconfiguration controller and requests the reconfiguration controller
to start streaming MIF information.

Ethernet Packet Classifier—decodes the packet type of incoming PTP packets and
returns the decoded information to the 10M-10GbE MAC.
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m Ethernet ToD Clock—provides 64-bits and/or 96-bits time-of-day to TX and RX of
10GbE Ethernet MAC.

m Pulse Per Second Module—returns pulse per second (pps) to user.

m  Avalon-MM Master Translator—provides access to the registers of the following
components through the Avalon-MM interface:

. MAC
m Backplane Ethernet 10GBASE-KR PHY
m Transceiver Reconfiguration Controller

m ToD Clock

6.2.1. Base Addresses

Table 6-1 lists the design example components that you can reconfigure to suit your
verification objectives. To reconfigure the components, write to their registers using
the base addresses listed in the table and the register offsets described in the
components' user guides.

Table 6-1. Base Addresses of 10M-10GhE MAC with IEEE 1588v2 Design Example Components

Component Base Address
MAC Channel 0 0x00000
MAC Channel 1 0x20000
Backplane Ethernet 10GBASE-KR PHY Channel 0 0x80000
Backplane Ethernet 10GBASE-KR PHY Channel 1 0x80800
Configure Reconfiguration Channel 0 0x80400
Configure Reconfiguration Channel 1 0x80500
Time of Day Clock (1G) Channel 0 0x81100
Time of Day Clock (10G) Channel 0 0x81000
Time of Day Clock (1G) Channel 1 0x81300
Time of Day Clock (10G) Channel 1 0x81200

"=~ This design example uses a 19-bit width address bus to access the base address of
components other than the MAC.

6.3. 10M-10GbE MAC with IEEE 1588v2 Design Example Files

Figure 6-2 shows the directory structure for the 10M-10GbE MAC with IEEE 1588v2
design examples and testbenches.

Figure 6-2. 10M-10GhE MAC with IEEE 1588v2 Design Example Folders

<ip_lib>/ethernet/altera_eth_10g_design_example

altera_eth_10g_mac_hase_kr_1588

testbench

reconfig

February 2014 Altera Corporation 10-Gbps Ethernet MAC MegaCore Function User Guide



Chapter 6: 10M-10GbE MAC with IEEE 1588v2 Design Example
Creating a New 10M-10GbE MAC with |EEE 1588v2 Design

Table 6-2 lists the files in the ..\altera_eth_10g_mac_base_kr_1588 directory.

Table 6-2. 10M-10GhE MAC with IEEE 1588v2 Design Example Files

File Name Description

altera_eth_10g_mac_base_kr_1588_top.sv

The top-level entity file of the design example for
verification in hardware.

altera_eth_10g_mac_base_kr_1588_top.sdc

The Quartus Il SDC constraint file for use with
the TimeQuest timing analyzer.

altera_eth_10g_mac_base_kr_1588.qsys 10GBASE-KR PHY design example with IEEE

A Qsys file for the 10M-10GbE MAC and

1588v2 option enabled.

6.4. Creating a New 10M-10GbE MAC with IEEE 1588v2 Design

You can use the Quartus II software to create a new 10M-10GbE MAC with IEEE
1588v2 design. Altera provides a Qsys design example file that you can customize to
facilitate the development of your 10M-10GbE MAC with IEEE 1588v2 design.

To create the design, perform the following steps:

1.
2.

10.

11.

Launch the Quartus II software and open a new Quartus II Project.

Run add_design_example_files.tcl in the Quartus II software to add the required
design example files to the project.

Launch Qsys from the Tools menu and open the
altera_eth_10g_mac_base_kr_1588.gsys file.

Turn off the additional module under the Use column if your design does not
require it. This action disconnects the module from the 10M-10GbE MAC with
IEEE 1588v2 system.

Double-click on eth_10g_design_example_0 and eth_10g_design_example_1 to
launch the parameter editor.

Specify the required parameters in the parameter editor.
Click Finish.

On the Generation tab, select either a Verilog HDL or VHDL simulation model
and make sure that the Create HDL design files for synthesis option is turned on.

Click Generate to generate the simulation and synthesis files.

Launch the MegaWizard Plug-in Manager from the Tools menu. Select Edit an
existing custom megafunction variation and regenerate reconfig.v from the
reconfig folder.

Click Finish.
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6.5. 10M-10GbE with IEEE 1588v2 Testhench

Altera provides testbench for you to verify the 10M-10GbE with IEEE 1588v2 design
example. The following sections describe the testbench, its components, and use.

6.5.1. 10M-10GbE with IEEE 1588v2 Testhench

The testbench operates in loopback mode. Figure 6-3 shows the flow of the packets in
the design example.

Figure 6-3. Testhench Block Diagram
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avalon_bfm_wrapper.sv Ethernet
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Avalon Driver Monitor

6.5.2. 10M-10GbE with IEEE 1588v2 Testhench Components

The testbenches comprise the following modules:
m Device under test (DUT)—the design example.

m Avalon driver—uses Avalon-ST master bus functional models (BFMs) to exercise
the transmit and receive paths. The driver also uses the master Avalon-MM BFM
to access the Avalon-MM interfaces of the design example components.

m Packet monitors—monitors the transmit and receive datapaths, and displays the
frames in the simulator console.
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6.5.3. 10M-10GbE MAC with IEEE 1588v2 Testhench Files

The <ip library>/ethernet/altera_eth_10g_design_example/testbench directory
contains the testbench files.

Table 6-3 describes the files that implement the 10M-10GbE MAC with IEEE 1588v2
testbench.

Table 6-3. 10M-10GbE MAC with IEEE 1588v2 Testhench Files

File Name Description

A wrapper for the Avalon BFMs that the avalon_driver.sv file
uses.

A SystemVerilog HDL driver that utilizes the BFMs to exercise
avalon_driver.sv the transmit and receive path, and access the Avalon-MM
interface.

A SystemVerilog HDL testbench that contains parameters to
avalon_if_params_pkg.sv configure the BFMs. Because the configuration is specific to
the DUT, you must not change the contents of this file.

A SystemVerilog HDL testbench that monitors the Avalon-ST
transmit and receive interfaces.

A SystemVerilog HDL package that contains the default
parameter settings of the testbench.

A SystemVerilog HDL class that defines the Ethernet frames.
The avalon_driver.sv file uses this class.

A SystemVerilog HDL package that maps addresses to the
Avalon-MM control registers.

A SystemVerilog HDL class that defines the timestamp in the
testbench.

A Tcl script that starts a simulation session in the ModelSim
simulation software.

A SystemVerilog HDL testbench file that controls the flow of
the testbench.

The top-level testhench file. This file includes the customized
10M-10GbE MAC, which is the device under test (DUT), a

avalon_bfm_wrapper.sv

avalon_st_eth_packet_monitor.sv

default_test_params_pkg.sv

eth_mac_frame.sv

eth_register_map_params_pkg.sv

ptp_timestamp.sv

th_run.tel

th_testcase.sv

th_top.sv client packet generator, and a client packet monitor along
with other logic blocks.
wave.do A signal tracing macro script for use with the ModelSim

simulation software to display testbench signals.
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6.5.4. 10M-10GbE MAC with IEEE 1588v2 Testhench Simulation Flow

Upon a simulated power-on reset, the testbench performs the following operations:

1.

SARER L

Initializes the DUT by configuring the following options through the Avalon-MM
interface:

m Changes both channel 1 and channel 0 to be operating speed at 10 Gbps.
m  Waits for both the MAC and PHY to be ready.

m Configures the MAC. In the MAC, enables address insertion on the transmit
path and sets the transmit and receive primary MAC address to EE-CC-88-CC-
AA-EE. Also enables CRC insertion on transmit path.

m Configures Timestamp Unit in the MAC, by setting periods and path delay
adjustments of the clocks.

m  Configures ToD clock by loading a predefined time value.

m  Configures clock mode of channel-0 Packet Classifier to Ordinary Clock mode,
and channel-1 Packet Classifier to End-to-end Transparent Clock mode.

Starts packet transmission. The testbench sends a total of seven packets:

m 64-byte basic Ethernet frames

m 1l-step PTP Sync message over Ethernet

m 1l-step PTP Sync message over UDP/IPv4 with VLAN tag

m 2-step PTP Sync message over UDP/IPv6 with stacked VLAN tag

m  1-step PTP Delay Request message over Ethernet

m 2-step PTP Delay Request message over UDP/IPv4 with VLAN tag

m 1-step PTP Delay Request message over UDP/IPv6 with stacked VLAN tag
Displays the MAC statistics on the transcript panel.

Changes the operating speed for both channels to 1 Gbps, 100 Mbps, and 10 Mbps.
Repeats steps 1 to 3.

Stops packet transmission and display statistics counter of the MAC.

6.5.5. Simulating 10M-10GbE MAC with IEEE 1588v2 Testhench with
ModelSim Simulator

To use the ModelSim simulator to simulate the testbench design, follow these steps:

1.

Copy the respective design example directory to your preferred project directory:
altera_eth_10g_mac_base_kr_1588 from
<ip library>/ethernet/altera_eth_10g_design_example.

Launch Qsys from the Tools menu and open the
altera_eth_10g_mac_base_kr_1588.qsys file.

On the Generation tab, select either a Verilog HDL or VHDL simulation model.

Click Generate to generate the simulation and synthesis files.
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5. Run the following command to set up the required libraries, to compile the
generated IP Functional simulation model, and to exercise the simulation model
with the provided testbench:

do tb run.tcl#
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The 10GbE MAC IP core handles the flow of data between a client and Ethernet
network through a 10-Gbps Ethernet PHY. On the transmit path, the MAC accepts
client frames and constructs Ethernet frames by inserting various control fields, such
as checksums before forwarding them to the PHY. Similarly, on the receive path, the
MAC accepts Ethernet frames via a PHY, performs checks, and removes the relevant
fields before forwarding the frames to the client. You can configure the MAC to collect
statistics on both transmit and receive paths. You can opt to use either 10GbE MAC,
1G/10GbE MAC, or 10M-10GbE MAC variant.

This chapter describes the MAC IP core, its architecture, interfaces, data paths,
registers, and interface signals.

71.1. Architecture

The 10GbE MAC IP core is a composition of three blocks: MAC receiver (MAC RX),
MAC transmitter (MAC TX), and Avalon-MM bridge. The MAC RX and MAC TX
handle data flow between the client and Ethernet network.

The Avalon-MM bridge provides a single interface to all Avalon-MM interfaces within
the MAC, which allows a host to access 32-bit configuration and status registers, and
statistics counters.

February 2014  Altera Corporation 10-Gbps Ethernet MAC MegaCore Function User Guide



7-2

Chapter 7: Functional Description
Architecture

Figure 7-1, Figure 7-2, and Figure 7-3 show the block diagrams of the 10GbE MAC,
1G/10GbE MAC, and 10M-10GbE MAC variants of the MAC IP core.

Figure 7-1. 10GbE MAC IP Core Block Diagram
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Figure 7-3. 10M-10GhE MAC IP Core Block Diagram

10M-10GbE MAC
_ XGMII Transmit
64-bit 70 Interface
Avalon-ST > _ GMII Transmit
Transmit Interface 64 MACTx g Interface
_ Ml Transmit
4 Interface
v A A
Avalon-MM Avalon-MM Flow Link
Configuration™< 2| Bridge Control Fault
V' N
_ XGMII Receive
D 7 Interface
GMII Receive
-bi MAC Rx <
Aval<§5:f-8b'llE < 8 Interface
Receive Interface 64 . MIl Receive
4 Interface

1.2. Interfaces
The 10GbE MAC IP core offers the following modes:

m Avalon-ST transmit and receive interface on the client side

Avalon-MM control and status register interface

SDR XGMII transmit and receive interface on the network side (10GbE MACQC)

or

GMII or SDR XGMII transmit and receive interface on the network side (1G/10G
MACQC)

or

MII, GMII or SDR XGMII transmit and receive interface on the network side
(10M-10G MAC)

7.2.1. Avalon-ST Interface

The client-side interface of the MAC employs the Avalon-ST protocol, which is a
synchronous point-to-point, unidirectional interface that connects the producer of a
data stream (source) to a consumer of the data (sink). The key properties of this
interface include:

Frame transfers marked by startofpacket and endofpacket signals.
Signals from source to sink are qualified by the valid signal.
Errors marking a current packet are aligned with the end-of-packet cycle.

Use of the ready signal by the sink to backpressure the source. The source must
respond to the ready signal from sink by deasserting the valid signal after a fixed
number of cycles defined by the ready latency.
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In the MAC, the Avalon-ST interface acts as a sink in the transmit datapath and source
in the receive datapath. These interfaces are 64 bits wide and support packets,
backpressure, and error. The ready latency on these interfaces is 0 and the MAC
expects the empty signal to contain a valid value.
“ e For more information about the Avalon-ST interface, refer to the Avalon Interface
Specifications.

7.2.2. SDR XGMII

The network-side interface of the 10GbE MAC implements the SDR version of the
XGMII protocol. The SDR XGMII consists of 64-bit data bus and 8-bit control bus
operating at 156.25 MHz. The data bus carries the MAC frame; the most significant
byte occupies the least significant lane.

7.2.3. GMII

The network-side interface of the 1IGbE MAC implements the GMII protocol for the
1Gpbs mode. The GMII defines speeds up to 1000 Mbit/s, implemented using an
eight-bit data interface operating at 125 MHz.

7.2.4. Mil

The network-side interface of the 10M/100MbE MAC implements the MII protocol
for the 10 Mbps and 100 Mbps mode. The MII defines speeds up to 10Mbit/s and
100Mbit/s. The speed is implemented using a four-bit data interface operating at

125 MHz, with the clock enable signal to divide the clock to 25 MHz for 100 Mbps and
2.5 MHz for 10 Mbps.

7.2.5. Avalon-MM Control and Status Register Interface

The Avalon-MM control and status register interface is an Avalon-MM slave port. This
interface uses word addressing which provides host access to 32-bit configuration and
status registers, and statistics counters.
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1.3. Frame Types

The MAC supports the following frame types:
m Basic Ethernet frames, including jumbo frames.
m VLAN and stacked VLAN frames.

m Control frames, which include pause and PFC frames.

“ e Refer to Appendix A, Frame Format for the frame formats and fields.

7.4. Transmit Datapath

The MAC TX receives the client payload data with the destination and source
addresses, and appends various control fields. Depending on the MAC configuration,
the MAC TX could perform the following tasks: pads the payload to satisfy the
minimum Ethernet frame payload of 64 bytes, calculates and appends the CRC-32
field, modifies the source address, inserts inter-packet gap bytes, and accepts
client-defined preamble bytes.

To perform these tasks, the MAC TX deasserts the avalon_st_tx_ready signal during
the frame transfer.

Figure 7-4 shows the typical flow of frame through the MAC TX.

Figure 7-4. Typical Client Frame at Transmit Interface

Client Frame
Client-Defined Preamble Destination Source Type/ Payload (1) PAD [<53] @ i CRC32
163:0] Addi[47:0] | Addr{47:0] | Length[15:0] | [<p-1>:0] | [310]
(optional) (optional)
o (EEEEETCECERTTEEEEEETEEERITEEEE SR EEE Pt EEEEE Client - MAC Tx Interface  ------==---mmmreofomme e >
Y _MAC Frame \ 4 \ 4 \/
Preamble ! Destination Source Type/ Payload PAD CRC32 EFDI7:0 PG
55:0] SFD(7:0] Addr{47:0] | Addr47:0] | Length[15:0] | [<p-1>:0] [] 131:0] (7:0] [<l-15:0]

-
]

Y

Frame Length

Notes to Figure 7-4:

(1) <p> = payload size = 01500 bytes
(2) <$>=padding bytes = 0-46 bytes
(3) </>=number of IPG bytes

7.4.1. Frame Payload Padding

The MAC TX inserts pad bytes (0x00) into transmit frames when the payload length
doesn't meet the minimum length required:

m 46 bytes for basic frames
m 42 bytes for VLAN tagged frames
m 38 bytes for stacked VLAN tagged frames
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You can disable pad bytes insertion by setting the tx padins_control register to 0.
When disabled, the MAC IP forwards the frames to the receiver without checking the
frame length. Ensure that the minimum payload length is met; otherwise the current
frame may get corrupted. You can check for undersized frames by referring to the
statistics collected.

7.4.2. Address Insertion

By default, the MAC TX retains the source address received from the client. You can
configure the MAX TX to replace the source address with the primary MAC address
specified in the tx_addrins_macaddr0 and tx_addrins_macaddrl registers by setting
the bit tx addrins control[0] to 1.

7.4.3. Frame Check Sequence (CRC-32) Insertion

The MAC TX computes and inserts CRC-32 checksum into transmit frames. The MAC
TX computes the CRC-32 checksum over the frame bytes that include the source
address, destination address, length, data, and pad bytes. The CRC checksum
computation excludes the preamble, SFD, and FCS bytes.

The following equation shows the CRC polynomial, as specified in the IEEE 802.3
Standard:

FCS(X) = X4 X 4 XP e X2+ X0 X2 X e X0 B X e X+ X X X 41

The 32-bit CRC value occupies the FCS field with X3! in the least significant bit of the
first byte. The CRC bits are thus received in the following order: X3!, X30,..., X1, X0.

You can disable this function by setting the bit tx_crcins_control[1] to 0. You can
also choose to omit the logic for CRC computation and insertion to save resources.
When you disable or omit the CRC computation and insertion, the MAC does not
append the CRC bits to the automatically generated pause frames.

Figure 7-5 on page 7-7 shows the timing diagram of the Avalon-ST transmit and
receive interface where the FCS insertion function is on. The MAC TX receives the
frame without CRC-32 checksum and inserts CRC-32 checksum (4EBO0AF4) into the
frame. The frame is then loopback to the receive datapath with the
avalon_st_rx datal[63:0] containing the CRC-32 checksum.
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Figure 7-5. Avalon-ST Transmit and Receive Interface with CRC-32 Checksum Insertion

tx_clk_clk
avalon_st_tx_ready
avalon_st_tx_valid
avalon_st_tx_startofpacket
avalon_st_tx_endofpacket
avalon_st_tx_data[63:0]
avalon_st_tx_empty[2:0]

avalon_st_tx_error

rx_clk_clk
avalon_st_rx_ready
avalon_st_rx_valid
avalon_st_rx_startofpacket
avalon_st_rx_endofpacket
avalon_st_rx_data[63:0]
avalon_st_rx_empty[2:0]
avalon_st_rx_error{5:0]

Note to Figure 7-5:
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—_— =

[ 40
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[
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(1) This value (which varies depending on the frame size) indicates the number of symbols that are empty during the

cycles that mark the end of a frame.
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Figure 7-6 shows the timing diagram of the Avalon-ST transmit and receive interface
where the FCS insertion function is off. The MAC TX receives the frame which
contains a CRC-32 checksum (4EBO0AF4) and forwards the frame without performing
CRC computation. The frame with the same CRC-32 field is then loopback to the
receive datapath.

Figure 7-6. Avalon-ST Transmit and Receive Interface with CRC-32 Computation Disabled

avalon_st_tx_ready

L
avalon_st_tx_valid J L

avalon_st_tx_startofpacket

avalon_st_tx_endofpacket

avalon_st_tx_data[63:0]

avalon_st_tx_empty[2:0]

avalon_st_tx_error

avalon_st_rx_ready

avalon_st_rx_valid

_J
avalon_st_rx_startofpacket J—\
N

L
[
X X X X X X . 4EB30AF4

avalon_st_rx_empty[2:0] 0

avalon_st_rx_endofpacket

avalon_st_rx_data[63:0]

avalon_st_rx_error{5:0]

7.4.4. XGMII Encapsulation

The 10GbE MAC TX inserts 7-byte preamble, 1-byte SFD and 1-byte EFD (0xFD) into
frames received from the client. When you enable the preamble passthrough mode,
the 10GbE MAC TX accepts 8-byte client-defined preamble in the frames received
from the client and inserts a 1-byte EFD into the frames. For XGMII encapsulation, the
first byte of the preamble data is converted to a 1-byte START (OxFB).

An underflow could occur on the Avalon-ST transmit interface. An underflow occurs
when the avalon st tx valid signalis deasserted in the middle of frame
transmission. When this happens, the 10GbE MAC TX inserts an error character |E |
into the frame and forwards the frame to the XGMII.
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7.4.5. Inter-Packet Gap Generation and Insertion

The MAC TX maintains an average IPG between transmit frames as required by the
IEEE 802.3 Ethernet standard. The average IPG is maintained at 96 bit times (12 byte
times) using the deficit idle count (DIC). The MAC TX's decision to insert or delete
idle bytes depends on the value of the DIC; the DIC is bounded between a minimum
value of zero and maximum value of three. Averaging the IPG ensures that the MAC
utilizes the maximum available bandwidth.

7.4.6. SDR XGMII Transmission

To comply with the IEEE 802.3 Clause 46 Ethernet standard, the MAC TX ensures the
following when transmitting frames on the SDR XGMII:

m  Aligns the first byte of the frame to either lane 0 or lane 4 of the interface.

m Performs endian conversion. Transmit frames received from the client on the
Avalon-ST interface are big endian. Frames transmitted on the SDR XGMII are
little endian; the MAC TX therefore transmits frames on this interface from the
least significant byte.
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Figure 7-7 shows the timing for the transmit frames on the Avalon-ST interface and
the SDR XGMII. By comparing the data value in D3, the SDR XGMII performs endian
conversion by transmitting the frames from the least significant byte.

Figure 7-7. Endian Conversion

i

tx_clk_clk

avalon_st_tx_ready

I I
I I
I I
I I
| A
t t
avalon_st_tx_valid J } } L Data value:
I I D1: EECC88CCAAEEEECC
- I I
avalon_st_tx_startofpacket | | . D2 88CCAAEEQ02E0001
| |
I I D3: 0203040506070809
avalon_st_tx_endofpacket | |
| | D4: 0AOBOCODOEOF1011
avalon_st_tx_data [63:0] o1 | D2 [ s | os [ os [ o6 | o7 | s | D5: 121314151617181
) )
t t X X D6: 1A1B1C1DIE1F2021
avalon_st_tx_empty [2:0 | 10 4
-st_tx_empty (20) t t D7: 72829
I I
avalon_st_tx_error - I I - D8: 2A2B2C2D00000000
| SLIX_ I I
| |

ix_olk_olk
xqmi_ b data71] | i i [
xqmii tx_dataroe] | 05 _cc | o X‘ 09 k IR RS
xgmi tc_datalsz] | % % [
xgmii_tx_datal61:54] | 5570 | EE_ | 00 X‘ 08 ‘X 10 [ 18 [ 20 [ 28 [ oa |
xqmii b datalsa] | i i [
xgmi_tx_datalszas] ) s EE | o€ X‘ o7 X oF [ 7 [ [ e |
xqmi_tc_detafdd] | } } [
xmilb_dataf4336] ) 5500 | AA | 00 X 06 X £ J 16 | E [ [ & |
xqmi v datalss] | | | [
xgmi_x_data(427] ) 557 _cc | EE )d o k o [ 15 [ m [ [ |
xqmi_x_data26] | 3 i [
xqmil tx datal2sg] ) 550 ) 88 | AA X‘ 04 k oc [ 14 J e [ [ ac |
xami b daalt7] | i i [
xqmii tx_datalt6s] ) 55" | cc )Q: 0 :}( ® | 13 [ .8 [ [ = |
xomii b catalsl i i [
xmi_be data70] | FB_ | EE | 88 X‘ 0 x oo [ 12 [ a [ 2 [aa [ |
| |

Note to Figure 7-7:

(1) Inthe preamble passthrough mode, the MAC TX frame starts with a 1-byte START and a 7-byte client-defined
preamble.
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1.5. Receive Datapath

The MAC RX receives Ethernet frames from the SDR XGMII and forwards the
payload with relevant frame fields to the client after performing checks and filtering
invalid frames. Some frame fields are optionally removed from the frame before MAC
RX forwards the frame to the client.

Figure 7-8 shows the typical flow of frame through the MAC RX.

Figure 7-8. Typical Client Frame at Receive Interface

Client Frame
P | Client-Defined Preamble | Destination Source Type/ Payload (T]] _ | @ crcz
; Stz [55:0] Addr47:0] | Addr47:0] | Length(15